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Note: The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These
terms do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration.
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's path
protection feature, which may be used in any topological network configuration. Cisco does not recommend
using its path protection feature in any particular topological network configuration.
This chapter explains how to create Cisco ONS 15454 SDH low-order circuits and tunnels, high-order
circuits, Ethernet circuits, and virtual concatenated (VCAT) circuits. For additional information about ONS
15454 SDH circuits, refer to the "Circuits and Tunnels" chapter in the Cisco ONS 15454 SDH Reference
Manual.
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Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble conditions.
Refer to the Cisco ONS 15454 SDH Troubleshooting Guide as necessary.
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).
1. NTP-D127 Verify Network Turn-Up-Complete this procedure before you create any circuits.
2. NTP-D334 Create an Automatically Routed Low-Order VC11 Circuit-Complete as needed.
3. NTP-D335 Create a Manually Routed Low-Order VC11 Circuit-Complete as needed.
4. NTP-D336 Create a Unidirectional Low-Order VC11 Circuit with Multiple Drops-Complete as
needed.
5. NTP-D81 Create an Automatically Routed Low-Order VC12 Circuit-Complete as needed.
6. NTP-D82 Create a Manually Routed Low-Order VC12 Circuit-Complete as needed.
7. NTP-D83 Create a Unidirectional Low-Order VC12 Circuit with Multiple Drops-Complete as
needed.
8. NTP-D54 Create an Automatically Routed Low-Order VC3 Circuit-Complete as needed.
9. NTP-D55 Create a Manually Routed Low-Order VC3 Circuit-Complete as needed.
10. NTP-D56 Create a Unidirectional Low-Order VC3 Circuit with Multiple Drops-Complete as needed.
11. NTP-D133 Create an Automatically Routed Low-Order Tunnel-Complete as needed.
12. NTP-D134 Create a Manually Routed Low-Order Tunnel-Complete as needed.
13. NTP-D216 Create a Low-Order Path Tunnel for Port Grouping-Complete as needed.
14. NTP-D187 Create a Low-Order Aggregation Point-Complete as needed.
15. NTP-D135 Test Low-Order Circuits-Complete this procedure after you create an electrical circuit.
16. NTP-D323 Create an Automatically Routed High-Order Circuit-Complete as needed.
17. NTP-D324 Create a Manually Routed High-Order Circuit-Complete as needed.
18. NTP-D190 Create a Unidirectional High-Order Circuit with Multiple Drops-Complete as needed.
19. NTP-D62 Test High-Order Circuits-Complete this procedure after you create a high-order optical
circuit.

Before You Begin
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20. NTP-D139 Create a Half Circuit on an MS-SPRing or 1+1 Node-Complete this procedure as needed
to create a half circuit using an STM-N as a destination in a multiplex section-shared protection ring
(MS-SPRing) or 1+1 protection.
21. NTP-D140 Create a Half Circuit on an SNCP Ring Node-Complete as needed to create a half circuit
using an STM-N as a destination in an subnetwork connection protection (SNCP) ring.
22. NTP-D191 Create an E-Series EtherSwitch Circuit (Multicard or Single-Card Mode)-Complete as
needed.
23. NTP-D192 Create a Circuit for an E-Series Card in Port-Mapped Mode-Complete as needed.
24. NTP-D142 Create an E-Series Shared Packet Ring Ethernet Circuit-Complete as needed.
25. NTP-D143 Create an E-Series Hub-and-Spoke Ethernet Configuration-Complete as needed.
26. NTP-D144 Create an E-Series Single-Card EtherSwitch Manual Cross-Connect-Complete as needed.
27. NTP-D145 Create an E-Series Multicard EtherSwitch Manual Cross-Connect-Complete as needed.
28. NTP-D146 Test E-Series Circuits-Complete this procedure after creating E-Series SDH circuits.
29. NTP-D148 Create a Manual Cross-Connect for a G-Series or E-Series Card in Port-Mapped
Mode-Complete as needed.
30. NTP-D241 Provision G-Series Ports for Transponder Mode-Complete as needed.
31. NTP-D149 Test G-Series Circuits-Complete this procedure after creating G-Series SDH circuits.
32. NTP-D194 Create Overhead Circuits-Complete as needed to create data communications channel
(DCC) tunnels, create IP-encapsulated tunnels, provision orderwire, or create user data channel
(UDC) circuits.
33. NTP-D283 Create an Automatically Routed VCAT Circuit-Complete as needed.
34. NTP-D284 Create a Manually Routed VCAT Circuit-Complete as needed.
35. NTP-D325 Create an STM Test Circuit around the Ring-Complete as needed.
36. NTP-D350 Create a Server Trail-Complete as needed.
37. NTP-D358 Create an Automatically Routed Open-Ended SNCP High-Order Circuit-Complete as
needed.
Table 6-1 defines ONS 15454 SDH circuit creation terms and options.
Table 6-1: ONS 15454 SDH Circuit Options

Circuit
Option
Source
Destination
Automatic
circuit routing

Description

The circuit source is where the circuit enters the ONS 15454 SDH network.
The circuit destination is where the circuit exits an ONS 15454 SDH network.
Cisco Transport Controller (CTC) routes the circuit automatically on the shortest available
path based on routing parameters and bandwidth availability.
Manual routing allows you to choose a specific path, not just the shortest path chosen by
Manual circuit automatic routing. You can choose a specific VC4, VC3, VC11, or VC12 for each circuit
routing
segment and create circuits from work orders prepared by an Operations Support System
(OSS).
Low-order tunnels allow VC3, VC11, and VC12 circuits to pass through an ONS 15454
SDH without using low-order cross-connect resources on the cross-connect cards.
Low-order
Low-order circuits using tunnels use low-order cross-connect capacity only at the source
tunnel
and destination nodes. One low-order tunnel can carry three VC3s, and each VC3 can
contain a VC3 circuit span or 21 VC11 or VC12 circuit spans.
Low-order aggregation points (LAPs) allow low-order VC11, VC12, and VC3 circuits to be
Low-order
aggregated into a VC4 for handoff to non-ONS 15454 SDH networks or equipment, such as
aggregation
interoffice facilities (IOFs), switches, or digital access cross-connect systems (DACS). The
point
VC4 grooming end of the LAP requires an STM-N card. LAPs can be created on
MS-SPRings, 1+1, or unprotected nodes, but cannot be created on SNCP nodes.

Table 6-1: ONS 15454 SDH Circuit Options
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ONS 15454 SDH circuits are either low-order or high-order circuits. Table 6-2 shows the circuit source and
destination options for low-order VC3 circuits.
Table 6-2: CTC Circuit Source and Destination Options for Low-Order VC3 Circuits

Card

Ports

E3-12

12

DS3i-N-12

12

STM1E-12

12

OC3 IR 4/STM1

4

OC3 IR 4/STM1-8

8

OC12 IR/STM4 SH 1310 OC12 LR/STM4 LH 1310 OC12 LR/STM4
LH 1550

1

OC12 IR/STM4 SH 1310-4

4

All OC-48/STM16 cards (includes ML-Series card)

1

OC-192/STM64

1

CE-MR-10

10

MRC-12

12

MRC-2.5G-12

12

FC_MR-4

4

VC4s

VC3s
3 per
1 per port
VC4
3 per
1 per port
VC4
3 per
1 per port
VC4
3 per
1 per port
VC4
3 per
1 per port
VC4
3 per
4 per port
VC4
3 per
4 per port
VC4
3 per
16 per port
VC4
3 per
64 per port
VC4
3 per
16 per port
VC4
3 per
1, 4, or 161 per port
VC4
3 per
1, 4, or 161 per port
VC4
-

1. The number of VC4s depends on the Small Form-factor Pluggable (SFP) used as well as available backplane width and existing provisioned lines. For
additional details, refer to the ?Optical Cards? chapter in the Cisco ONS 15454 SDH Reference Manual.

Table 6-3 shows the circuit source and destination options for VC11 and VC12 circuits.
Table 6-3: CTC Circuit Source and Destination Options for Low-Order VC12 or VC11 Circuits

Card
E1-42

Ports
42
-

STM1E-12

12

1 per port

OC3 IR 4/STM1

4

1 per port

OC3 IR 4/STM1-8

8

1 per port

OC12 IR/STM4 SH 1310 OC12 LR/STM4 LH
1
1310 OC12 LR/STM4 LH 1550
OC12 IR/STM4 SH 1310-4
4

VC4s

4 per port
4 per port

VC3/TUG3s TUG2s VC11s/VC12s
1 per port
7 per
3 per VC4
3 per TUG2
TUG3
7 per
3 per VC4
3 per TUG2
TUG3
7 per
3 per VC4
3 per TUG2
TUG3
7 per
3 per VC4
3 per TUG2
TUG3
3 per VC4 7 per
3 per TUG2

Table 6-2: CTC Circuit Source and Destination Options for Low-Order VC3 Circuits
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All OC-48/STM16 cards (includes ML-Series
card)

1

16 per port

3 per VC4

OC-192/STM64

1

64 per port

3 per VC4

CE-MR-10

10

16 per port

3 per VC4

MRC-12

12

MRC-2.5G-12

12

FC_MR-4

4

1, 4, or 161
per port
1, 4, or 161
per port
-

3 per VC4
3 per VC4
-

TUG3
7 per
TUG3
7 per
TUG3
7 per
TUG3
7 per
TUG3
7 per
TUG3
-

3 per TUG2
3 per TUG2
3 per TUG2
3 per TUG2
3 per TUG2
-

1. The number of VC4s depends on the SFP used as well as available backplane width and existing provisioned lines. For additional details, refer to the
?Optical Cards? chapter in the Cisco ONS 15454 SDH Reference Manual.

Table 6-4 shows the options that appear for high-order circuits.
Table 6-4: CTC Circuit Source and Destination Options for High-Order VC4 Circuits

Card

Ports
E1-42
STM1E-12
12
OC3 IR 4/STM1
4
OC3 IR 4/STM1-8
8
OC12 IR/STM4, OC12 LR/STM4
1
OC12 IR 4/STM4, OC12 LR 4/STM4
4
All OC-48/STM16 cards (includes ML-Series card) 1
OC-192/STM64 (includes ML-MR-10 card)
1
CE-MR-10
10
MRC-12 and MRC-2.5G-12
12
FC_MR-4
4

VC4s
1
1 per port
1 per port
1 per port
4 per port
4 per port
16 per port
64 per port
16 per port
64 per port
1, 4, or 161 per port

1. The number of VC4s depends on the SFP used as well as available backplane width and existing provisioned lines. For additional details, refer to the
?Optical Cards? chapter in the Cisco ONS 15454 SDH Reference Manual.

NTP-D127 Verify Network Turn-Up
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure verifies that the ONS 15454 SDH network is ready for circuit
provisioning.
None
Turn Up a Network
Required
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create circuits. If you are already logged in, continue with Step 2.
2. From the View menu, choose Go to Network View. Wait for all the nodes that are part of the
network to appear on the network map. (Large networks might take several minutes to display all the
Table 6-3: CTC Circuit Source and Destination Options for Low-Order VC12 or VC11 Circuits
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nodes.)
Note: If this is the first time your computer has connected to this ONS 15454 SDH network,
the node icons are stacked on the left side of the graphic area, possibly out of view. Use the
scroll bar under the network map to display the icons. To separate the icons, press Ctrl and
drag and drop the icon to the new location. Repeat until all the nodes are visible on the
graphic area.
3. Verify node accessibility. In the network view, all node icons must be either green, yellow, orange,
or red.
If all network nodes do not appear after a few minutes, or if a node icon is gray with
"Unknown" under it, do not continue. Look at the Net box in the lower right corner of the
window. If it is gray, log in again, making sure not to check the Disable Network check box
in the CTC Login dialog box. If problems persist, see Turn Up a Network to review the
network turn-up procedure appropriate for your network topology, or refer to the Cisco ONS
15454 SDH Troubleshooting Guide for troubleshooting procedures.
4. Verify DCC connectivity. All nodes must be connected by green lines. If lines are missing or gray in
color, do not continue. See Turn Up a Network and follow the network turn-up procedure appropriate
for your network topology. Verify that all nodes have DCC connectivity before continuing. If DCCs
need to be created, complete the "DLP-D363 Provision Regenerator-Section DCC Terminations"
task.
5. Click the Alarms tab to view alarm descriptions. Investigate and resolve, if necessary, all critical
(red node icon) or major (orange node icon) alarms. Refer to the Cisco ONS 15454 SDH
Troubleshooting Guide to resolve alarms before continuing.
6. From the View menu, choose Go to Home View. Verify that the node is provisioned according to
your site or engineering plan:
1. View the cards that appear in the shelf map. Verify that the ONS 15454 SDH cards appear in
the specified slots.
2. Click the Provisioning > General tabs. Verify that the node name, contacts, date, time, and
Network Time Protocol/Simple Network Time Protocol (NTP/SNTP) server IP address (if
used) are correctly provisioned. If needed, make corrections using the "DLP-D140 Change
the Node Name, Date, Time, and Contact Information" task.
3. Click the Network tab. Verify that the IP address, Subnet mask, Default Router, Prevent
LCD IP Config, and Gateway Settings are correctly provisioned. If not, make corrections
using the NTP-D201 Change CTC Network Access.
4. Click the Protection tab. Verify that protection groups are created as specified in your site
plan. If the protection groups are not created, complete the NTP-D203 Modify or Delete
Card Protection Settings.
5. If the node is in an MS-SPRing, click the MS-SPRing tab. (If the node is not in an
MS-SPRing, continue with Substep 6.) Verify that the following items are provisioned as
specified in your site plan:
◊ MS-SPRing type (2-fiber or 4-fiber)
◊ MS-SPRing ring ID and node IDs
◊ Ring reversion time
◊ East and west card assignments
◊ (4-fiber MS-SPRings only) Span reversion and east/west protect card assignments
If you need to make corrections, see the NTP-D40 Provision MS-SPRing Nodes for
instructions.
6. Click the Security tab. Verify that the users and access levels are provisioned as specified. If
not, see the NTP-D30 Create Users and Assign Security to correct the information.
7. If Simple Network Management Protocol (SNMP) is used, click the SNMP tab and verify
the trap and destination information. If the information is not correct, see the NTP-D87
Change SNMP Settings to correct the information.
8. Click the Comm Channels tab. Verify that DCCs were created to the applicable STM-N
slots and ports. If DCCs were not created for the appropriate STM-N slots and ports, see
NTP-D127 Verify Network Turn-Up
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Turn Up a Network and complete the turn-up procedure appropriate for your network
topology.
9. Click the Timing tab. Verify that timing is provisioned as specified. If not, use the NTP-D85
Change Node Timing to make the changes.
10. Click the Alarm Profiles tab. If you provisioned optional alarm profiles, verify that the
alarms are provisioned as specified. If not, see the NTP-D71 Create, Download, and Assign
Alarm Severity Profiles to change the information.
11. Verify that the network element (NE) defaults listed in the status area of the node view
window are correct.
7. Repeat Step 6 for each node in the network.
8. Complete the appropriate circuit creation procedure from the NTP list in the Before You Begin.
Stop. You have completed this procedure.

NTP-D334 Create an Automatically Routed Low-Order VC11 Circuit
Purpose
Tools/Equipment

This procedure creates an automatically routed low-order VC11 circuit, which means
that CTC chooses the circuit route based on the parameters you specify and on the
software version.
The following cards must be installed at the circuit source and destination nodes:
XC-VXC-10G and optical cards (STM-N, MRC-12).

Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
Note: VC11 circuits can start and end only at optical cards.
1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. Complete the following:
1. On the shelf graphic, verify that XC-VXC-10G cross-connect cards are installed in Slots 8
and 10.
2. Click the Provisioning > Cross-Connect tabs and set the Low Order Payload Type to
VC-11 or VC-11 and VC-12 (Mixed Mode).
3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Number of Circuits-Enter the number of VC-11 circuits that you want to create. The default
is 1. If you are creating multiple circuits with the same slot and consecutive port numbers,
you can use Auto-ranged to create the circuits automatically.

NTP-D334 Create an Automatically Routed Low-Order VC11 Circuit
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♦ Auto-ranged-This check box is automatically selected if you enter more than 1 in the
Number of Circuits field. Auto-ranging creates identical (same source and destination),
sequential circuits automatically. Uncheck the box if you do not want CTC to create
sequential circuits automatically.
7. Click Next.
8. Define the circuit attributes (Figure 6-1):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC11.
♦ Bidirectional-Leave checked for this circuit (default).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this check box if you want to apply the state chosen in the State
field to the circuit source and destination ports. CTC applies the circuit state to the ports only
if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger
than the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning
dialog box shows the ports where the circuit state could not be applied. If the box is
unchecked, CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Check this check box if you want the circuit routed on protected drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you check this
check box, CTC shows only protected cards and ports as source and destination choices.
Figure 6-1: Setting Circuit Attributes for a Low-Order VC11 Circuit

Figure 6-1: Setting Circuit Attributes for a Low-Order VC11 Circuit
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9. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task. Otherwise, continue with Step 10.
10. Click Next.
11. Complete the "DLP-D186 Provision a Low-Order VC11 Circuit Source and Destination" task.
12. In the Circuit Routing Preferences area (Figure 6-2), choose Route Automatically. Two options are
available; choose either, both, or none based on your preferences.
⋅ Using Required Nodes/Spans-Check this check box if you want to specify nodes and
spans to include or exclude in the CTC-generated circuit route.
⋅ Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
⋅ Review Route Before Creation-Check this check box if you want to review and edit
the circuit route before the circuit is created.
Figure 6-2: Setting Circuit Routing Preferences

13. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 14. CTC creates a fully protected circuit route based on the path
diversity option you choose. Fully protected paths might or might not have SNCP
path segments (with primary and alternate paths), and the path diversity options
apply only to SNCP path segments, if any exist.
Figure 6-2: Setting Circuit Routing Preferences
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⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 16.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, and then continue with Step 16.
Caution! Circuits routed on MS-SPRing protection channels are not protected. They are preempted
during MS-SPRing switches.
14. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP, choose one
of the following:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
15. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP DRI, check
the Dual Ring Interconnect check box.
16. If you selected Using Required Nodes/Spans in Step 12, complete the following substeps. If not,
continue with Step 18.
1. Click Next.
2. In the Circuit Route Constraints For Auto Routing area, click a node or span on the circuit
map.
3. Click Include to include the node or span in the circuit. Click Exclude to exclude the node
or span from the circuit. The order in which you choose included nodes and spans is the
order in which the circuit will be routed. Click spans twice to change the circuit direction.
4. Repeat Substep 3 for each node or span that you wish to include or exclude.
5. Review the circuit route. To change the circuit routing order, choose a node from the
Required Nodes/Lines or Excluded Nodes Links lists and click the Up or Down buttons to
change the circuit routing order. Click Remove to remove a node or span.
17. Click Next. In the VC LO Matrix Optimization page, choose one of the following:
⋅ Create VC LO tunnel on transit nodes-This option is available if the VC11 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC11 circuits to pass through ONS
15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
⋅ Create VC LO aggregation point-This option is available if you are creating a VC11
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto an VC4 for
transport outside the ONS 15454 network, choose one of the following:
♦ VC4 grooming node is source-node, VC11 grooming node is
destination-node-Creates the LAP on the VC11 circuit source node. This
option is available only if the VC11 circuit originates on an STM-N card.

Figure 6-2: Setting Circuit Routing Preferences
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♦ VC4 grooming node is destination-node, VC11 grooming node is
source-node-Creates the LAP on the VC11 circuit destination node. This
option is available only if the VC11 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
18. If you selected Review Route Before Creation in Step 12, complete the following substeps. If not,
continue with Step 19.
1. Click Next.
2. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route.
Blue arrows show the circuit route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned circuit does not reflect the routing and configuration you want, click Back
to verify and change circuit information. If the circuit needs to be routed to a different path,
see the NTP-D335 Create a Manually Routed Low-Order VC11 Circuit.
19. Click Finish. One of the following results occurs, depending on the circuit properties you chose in
the Circuit Creation dialog box:
⋅ If you entered more than 1 in the Number of Circuits field and selected Auto-ranged,
CTC automatically creates the number of circuits entered in the Number of Circuits
field. If auto-ranging cannot complete all the circuits, for example, because
sequential ports are unavailable at the source or destination, a dialog box appears.
Set the new source or destination for the remaining circuits, then click Finish to
continue auto-ranging. After completing the circuits, the Circuits window appears.
⋅ If you entered more than 1 in the Number of Circuits field and did not choose
Auto-ranged, the Circuit Creation dialog box appears so you can create the
remaining circuits. Repeat Steps 6 through 18 for each additional circuit. After
completing the circuits, the Circuits window appears.
20. In the Circuits window, verify that the new circuits appear in the circuits list.
21. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.

NTP-D335 Create a Manually Routed Low-Order VC11 Circuit
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates a low-order VC11 circuit and allows you to provision
the circuit route.
The following cards must be installed at the circuit source and destination
nodes: XC-VXC-10G and optical cards (STM-N or MRC-12).
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. Complete the following:
1. On the shelf graphic, verify that XC-VXC-10G cross-connect cards are installed in Slots 8
and 10.
2. Click the Provisioning > Cross-Connect tabs and set the Low Order Payload Type to
VC-11 or VC-11 and VC-12 (Mixed Mode).

NTP-D335 Create a Manually Routed Low-Order VC11 Circuit
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3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Number of Circuits-Enter the number of VC11 circuits that you want to create. The default is
1. If you are creating multiple circuits with the same slot and consecutive port numbers, you
can use Auto-ranged to create the circuits automatically.
♦ Auto-ranged-This check box is automatically checked if you enter more than 1 in the
Number of Circuits field. Auto-ranging creates identical (same source and destination),
sequential circuits automatically. Uncheck the box if you do not want CTC to create
sequential circuits automatically.
7. Click Next.
8. Define the circuit attributes (Figure 6-1):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC11.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Select this check box if you want to apply the state chosen in the State
field to the circuit source and destination ports. CTC applies the circuit state to the ports only
if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger
than the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning
dialog box shows the ports where the circuit state could not be applied. If the box is
unchecked, CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Check this check box if you want the circuit routed on protected drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you check this
NTP-D335 Create a Manually Routed Low-Order VC11 Circuit
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check box, CTC shows only protected cards and ports as source and destination choices.
9. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task. Otherwise, continue with Step 10.
10. Click Next.
11. Complete the "DLP-D186 Provision a Low-Order VC11 Circuit Source and Destination" task.
12. In the Circuit Routing Preferences area (Figure 6-2), uncheck Route Automatically.
13. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 14. Fully protected paths might or might not have SNCP path
segments (with primary and alternate paths), and the path diversity options apply
only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 17.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, and then continue with Step 17.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted
during MS-SPRing switches.
14. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP, choose a
Node-Diverse Path option:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within the
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired- Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
15. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP DRI, click
the Dual Ring Interconnect check box.
16. Click Next. In the VC LO Matrix Optimization page, choose one of the following:
⋅ Create VC LO tunnel on transit nodes-This option is available if the VC11 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC11 circuits to pass through ONS
15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
⋅ Create VC LO aggregation point-This option is available if you are creating a VC11
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto a VC4 for
transport outside the ONS 15454 SDH network, choose one of the following:
♦ VC4 grooming node is source-node, VC11 grooming node is
destination-node-Creates the LAP on the VC11 circuit source node. This
option is available only if the VC11 circuit originates on an STM-N card.
NTP-D335 Create a Manually Routed Low-Order VC11 Circuit
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♦ VC4 grooming node is destination-node, VC11 grooming node is
source-node-Creates the LAP on the VC11 circuit destination node. This
option is available only if the VC11 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
17. Click Next. In the Route Review/Edit area, node icons appear for circuit routing. The circuit source
node is selected. Green arrows pointing from the source node to other network nodes indicate spans
that are available for routing the circuit.
18. Complete the "DLP-D187 Provision a Low-Order VC11 Circuit Route" task for the VC11 circuit
you are creating.
19. Click Finish. CTC compares your manually provisioned circuit route with the specified path
diversity option you chose in Step 14. If the path does not meet the specified path diversity
requirement, CTC displays an error message and allows you to change the circuit path.
20. If you entered more than 1 in the Number of Circuits field, the Circuit Creation dialog box appears so
you can create the remaining circuits. Repeat Steps 6 through 19 for each additional circuit.
21. When all the circuits are created, the main Circuits window appears. Verify that the circuits you
created are correct.
22. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.

NTP-D336 Create a Unidirectional Low-Order VC11 Circuit with
Multiple Drops
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates a unidirectional low-order VC11 circuit with multiple
drops (destinations).
The following cards must be installed at the circuit source and destination
nodes: XC-VXC-10G and optical cards (STM-N or MRC-12).
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. Complete the following:
1. On the shelf graphic, verify that XC-VXC-10G cross-connect cards are installed in Slots 8
and 10.
2. Click the Provisioning > Cross-Connect tabs and set the Low Order Payload Type to
VC-11 or VC-11 and VC-12 (Mixed Mode).
3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default (1) unchanged.
♦ Auto-ranged-Unavailable when the Number of Circuits field is 1.
7. Click Next.
8. Define the circuit attributes:
NTP-D336 Create a Unidirectional Low-Order VC11 Circuit with Multiple Drops
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♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC11.
♦ Bidirectional-Uncheck for this circuit.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this box if you want to apply the state chosen in the State field to
the circuit source and destination ports. CTC applies the circuit state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog
box shows the ports where the circuit state could not be applied. If the box is unchecked,
CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Check this box if you want the circuit routed to protect drops only, that is,
to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC
displays only protected cards as source and destination choices.
9. Click Next.
10. Complete the "DLP-D186 Provision a Low-Order VC11 Circuit Source and Destination" task.
11. In the Circuit Routing Preferences area, uncheck Route Automatically. When Route Automatically
is not selected, the Using Required Nodes/Spans and Review Route Before Circuit Creation check
boxes are unavailable.
12. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 13. Fully protected paths might or might not have SNCP path
segments (with primary and alternate paths), and the path diversity options apply
only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 16.
NTP-D336 Create a Unidirectional Low-Order VC11 Circuit with Multiple Drops
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⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, and then continue with Step 16.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted
during MS-SPRing switches.
13. If you selected Fully Protected Path in Step 12 and the circuit will be routed on an SNCP, choose one
of the following:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within the
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
14. If you selected Fully Protected Path in Step 12 and the circuit will be routed on an SNCP DRI, click
the Dual Ring Interconnect check box.
15. Click Next. In the VC LO Matrix Optimization page, choose one of the following:
⋅ Create VC LO tunnel on transit nodes-This option is available if the VC11 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC11 circuits to pass through ONS
15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
⋅ Create VC LO aggregation point-This option is available if you are creating a VC11
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto an VC4 for
transport outside the ONS 15454 SDH network, choose one of the following:
♦ VC4 grooming node is source-node, VC11 grooming node is
destination-node-Creates the LAP on the VC11 circuit source node. This
option is available only if the VC11 circuit originates on an STM-N card.
♦ VC4 grooming node is destination-node, VC11 grooming node is
source-node-Creates the LAP on the VC11 circuit destination node. This
option is available only if the VC11 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
16. Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit
manually. The circuit source node is selected. Green arrows pointing from the source node to other
network nodes indicate spans that are available for routing the circuit.
17. Complete the "DLP-D187 Provision a Low-Order VC11 Circuit Route" task for the VC11 circuit
you are creating.
18. Click Finish. CTC completes the circuit and the Circuits window appears.
19. In the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit,
and Search buttons become active.
20. Click Edit (or double-click the circuit row). The Edit Circuit window appears with the General tab
selected.
NTP-D336 Create a Unidirectional Low-Order VC11 Circuit with Multiple Drops
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All nodes in the DCC network appear on the network. Circuit source and destination
information appears under the source and destination nodes. To see a detailed view
of the circuit, click Show Detailed Map. To rearrange a node icon, select the node,
press Ctrl, then drag and drop the icon to the new location.
21. In the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.
22. Click Create.
23. In the Define New Drop dialog box, create the new drop:
1. Node-Choose the target node for the circuit drop.
2. Slot-Choose the target card and slot.
3. Port, VC4, VC3/TUG3, TUG2, VC11-Choose the Port, VC4, VC3/TUG3, TUG2, or VC11
from the Port, VC4, VC3/TUG3, TUG2, or VC11 drop-down lists. The card selected in Step
b determines the fields that appear. See Table 6-3 for a list of options.
4. The routing preferences for the new drop match those of the original circuit. However, you
can modify the following:
◊ If the original circuit was routed on a protected SNCP path, you can
change the nodal diversity options: Nodal Diversity Required, Nodal
Diversity Desired, or Link Diversity Only. See Step 13 for
descriptions.
◊ If the original circuit was not routed on a protected path, the
Protection Channel Access option is available. See Step 12 for a
description of the Protection Channel Access option.
5. Click OK. The new drop appears in the Drops list.
24. If you need to create additional drops for the circuit, repeat Steps 22 and 23 to create the additional
drops.
25. Click Close. The Circuits window appears.
26. Verify that the new drops appear in the Destination column for the circuit that you edited. If they do
not appear, repeat Steps 5 through 25, making sure that all options are provisioned correctly.
27. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.

NTP-D81 Create an Automatically Routed Low-Order VC12 Circuit
Purpose
Tools/Equipment

This procedure creates an automatically routed low-order VC12 circuit, meaning that
CTC chooses the circuit route based on the parameters you specify and on the
software version.
XC-VXC-10G, XC-VXL-10G, or XC-VXL-2.5G cards must be installed at the circuit
source and destination nodes.

Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
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1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. Complete the following:
1. On the shelf graphic, verify that XC-VXC-10G, XC-VXL-10G, or XC-VXL-2.5G
cross-connect cards are installed in Slots 8 and 10.
2. Click the Provisioning > Cross-Connect tabs and set the Low Order Payload Type to
VC-12 or VC-11 and VC-12 (Mixed Mode).
3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Number of Circuits-Enter the number of VC-12 circuits that you want to create. The default
is 1. If you are creating multiple circuits with the same slot and consecutive port numbers,
you can use Auto-ranged to create the circuits automatically.
♦ Auto-ranged-This check box is automatically selected if you enter more than 1 in the
Number of Circuits field. Auto-ranging creates identical (same source and destination),
sequential circuits automatically. Uncheck the box if you do not want CTC to create
sequential circuits automatically.
7. Click Next.
8. Define the circuit attributes (Figure: Setting Circuit Attributes for a Low-Order VC12 Circuit):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC12.
♦ Bidirectional-Leave checked for this circuit (default).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this check box if you want to apply the state chosen in the State
field to the circuit source and destination ports. CTC applies the circuit state to the ports only
if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger
than the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning
NTP-D81 Create an Automatically Routed Low-Order VC12 Circuit
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dialog box shows the ports where the circuit state could not be applied. If the box is
unchecked, CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Check this check box if you want the circuit routed on protected drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you check this
check box, CTC shows only protected cards and ports as source and destination choices.
Figure 6-3: Setting Circuit Attributes for a Low-Order VC12 Circuit

9. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task. Otherwise, continue with Step 10.
10. Click Next.
11. Complete the "DLP-D95 Provision a Low-Order VC12 Circuit Source and Destination" task.
12. In the Circuit Routing Preferences area (Figure 6-4), choose Route Automatically. Two options are
available; choose either, both, or none based on your preferences.
⋅ Using Required Nodes/Spans-Check this check box if you want to specify nodes and
spans to include or exclude in the CTC-generated circuit route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
⋅ Review Route Before Creation-Check this check box if you want to review and edit
the circuit route before the circuit is created.
Figure 6-4: Setting Circuit Routing Preferences
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13. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 14. CTC creates a fully protected circuit route based on the path
diversity option you choose. Fully protected paths might or might not have SNCP
path segments (with primary and alternate paths), and the path diversity options
apply only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 16.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, and then continue with Step 16.
Caution! Circuits routed on MS-SPRing protection channels are not protected. They are preempted
during MS-SPRing switches.
14. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP, choose one
of the following:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
15. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP DRI, check
the Dual Ring Interconnect check box.
16. If you selected Using Required Nodes/Spans in Step 12, complete the following substeps. If not,
continue with Step 18.
1. Click Next.
2. In the Circuit Route Constraints For Auto Routing area, click a node or span on the circuit
map.
3. Click Include to include the node or span in the circuit. Click Exclude to exclude the node
or span from the circuit. The order in which you choose included nodes and spans is the
order in which the circuit will be routed. Click spans twice to change the circuit direction.
4. Repeat Substep 3 for each node or span that you wish to include or exclude.

Figure 6-4: Setting Circuit Routing Preferences
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5. Review the circuit route. To change the circuit routing order, choose a node from the
Required Nodes/Lines or Excluded Nodes Links lists and click the Up or Down buttons to
change the circuit routing order. Click Remove to remove a node or span.
17. Click Next. In the VC LO Matrix Optimization page, choose one of the following:
⋅ Create VC LO tunnel on transit nodes-This option is available if the VC12 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC12 circuits to pass through ONS
15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
⋅ Create VC LO aggregation point-This option is available if you are creating a VC12
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto an VC4 for
transport outside the ONS 15454 network, choose one of the following:
♦ VC4 grooming node is source-node, VC12 grooming node is
destination-node-Creates the LAP on the VC12 circuit source node. This
option is available only if the VC12 circuit originates on an STM-N card.
♦ VC4 grooming node is destination-node, VC12 grooming node is
source-node-Creates the LAP on the VC12 circuit destination node. This
option is available only if the VC12 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
18. If you selected Review Route Before Creation in Step 12, complete the following substeps. If not,
continue with Step 19.
1. Click Next.
2. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route.
Blue arrows show the circuit route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned circuit does not reflect the routing and configuration you want, click Back
to verify and change circuit information. If the circuit needs to be routed to a different path,
see the NTP-D82 Create a Manually Routed Low-Order VC12 Circuit.
19. Click Finish. One of the following results occurs, depending on the circuit properties you chose in
the Circuit Creation dialog box:
⋅ If you entered more than 1 in the Number of Circuits field and selected Auto-ranged,
CTC automatically creates the number of circuits entered in the Number of Circuits
field. If auto-ranging cannot complete all the circuits, for example, because
sequential ports are unavailable at the source or destination, a dialog box appears.
Set the new source or destination for the remaining circuits, then click Finish to
continue auto-ranging. After completing the circuits, the Circuits window appears.
⋅ If you entered more than 1 in the Number of Circuits field and did not choose
Auto-ranged, the Circuit Creation dialog box appears so you can create the
remaining circuits. Repeat Steps 6 through 18 for each additional circuit. After
completing the circuits, the Circuits window appears.
20. In the Circuits window, verify that the new circuits appear in the circuits list.
21. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.
Figure 6-4: Setting Circuit Routing Preferences
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NTP-D82 Create a Manually Routed Low-Order VC12 Circuit
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates low-order VC12 circuit and allows you to provision the
circuit route.
XC-VXC-10G, XC-VXL-10G, or XC-VXL-2.5G cards must be installed at the
circuit source and destination nodes.
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. Complete the following:
1. On the shelf graphic, verify that XC-VXC-10G, XC-VXL-10G, or XC-VXL-2.5G
cross-connect cards are installed in Slots 8 and 10.
2. Click the Provisioning > Cross-Connect tabs and set the Low Order Payload Type to
VC-12 or VC-11 and VC-12 (Mixed Mode).
3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Number of Circuits-Enter the number of VC12 circuits that you want to create. The default is
1. If you are creating multiple circuits with the same slot and consecutive port numbers, you
can use Auto-ranged to create the circuits automatically.
♦ Auto-ranged-This check box is automatically checked if you enter more than 1 in the
Number of Circuits field. Auto-ranging creates identical (same source and destination),
sequential circuits automatically. Uncheck the box if you do not want CTC to create
sequential circuits automatically.
7. Click Next.
8. Define the circuit attributes (Figure 6-1):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC12.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
NTP-D82 Create a Manually Routed Low-Order VC12 Circuit
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◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Select this check box if you want to apply the state chosen in the State
field to the circuit source and destination ports. CTC applies the circuit state to the ports only
if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger
than the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning
dialog box shows the ports where the circuit state could not be applied. If the box is
unchecked, CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Check this check box if you want the circuit routed on protected drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you check this
check box, CTC shows only protected cards and ports as source and destination choices.
9. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task. Otherwise, continue with Step 10.
10. Click Next.
11. Complete the "DLP-D95 Provision a Low-Order VC12 Circuit Source and Destination" task.
12. In the Circuit Routing Preferences area (Figure 6-2), uncheck Route Automatically. When Route
Automatically is not selected, the Using Required Nodes/Spans and Review Route Before Circuit
Creation check boxes are unavailable.
13. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 14. Fully protected paths might or might not have SNCP path
segments (with primary and alternate paths), and the path diversity options apply
only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 17.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, and then continue with Step 17.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted
during MS-SPRing switches.
14. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP, choose a
Node-Diverse Path option:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within the
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired- Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.

NTP-D82 Create a Manually Routed Low-Order VC12 Circuit
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⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
15. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP DRI, click
the Dual Ring Interconnect check box.
16. Click Next. In the VC LO Matrix Optimization page, choose one of the following:
⋅ Create VC LO tunnel on transit nodes-This option is available if the VC12 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC12 circuits to pass through ONS
15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
⋅ Create VC LO aggregation point-This option is available if you are creating a VC12
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto a VC4 for
transport outside the ONS 15454 SDH network, choose one of the following:
♦ VC4 grooming node is source-node, VC12 grooming node is
destination-node-Creates the LAP on the VC12 circuit source node. This
option is available only if the VC12 circuit originates on an STM-N card.
♦ VC4 grooming node is destination-node, VC12 grooming node is
source-node-Creates the LAP on the VC12 circuit destination node. This
option is available only if the VC12 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
17. Click Next. In the Route Review/Edit area, node icons appear for circuit routing. The circuit source
node is selected. Green arrows pointing from the source node to other network nodes indicate spans
that are available for routing the circuit.
18. Complete the "DLP-D3 Provision a Low-Order VC12 Circuit Route" task on for the VC12 circuit
you are creating.
19. Click Finish. CTC compares your manually provisioned circuit route with the specified path
diversity option you chose in Step 14. If the path does not meet the specified path diversity
requirement, CTC displays an error message and allows you to change the circuit path.
20. If you entered more than 1 in the Number of Circuits field, the Circuit Creation dialog box appears so
you can create the remaining circuits. Repeat Steps 6 through 19 for each additional circuit.
21. When all the circuits are created, the main Circuits window appears. Verify that the circuits you
created are correct.
22. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.

NTP-D83 Create a Unidirectional Low-Order VC12 Circuit with
Multiple Drops
Purpose
Tools/Equipment

This procedure creates a unidirectional low-order VC12 circuit with multiple drops
(destinations).
XC-VXC-10G, XC-VXL-10G, or XC-VXL-2.5G cards must be installed at the
circuit source and destination nodes.

NTP-D83 Create a Unidirectional Low-Order VC12 Circuit with Multiple Drops
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Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. Complete the following:
1. On the shelf graphic, verify that XC-VXC-10G, XC-VXL-10G, or XC-VXL-2.5G
cross-connect cards are installed in Slots 8 and 10.
2. Click the Provisioning > Cross-Connect tabs and set the Low Order Payload Type to
VC-12 or VC-11 and VC-12 (Mixed Mode).
3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default unchanged (1).
♦ Auto-ranged-Unavailable when the Number of Circuits field is 1.
7. Click Next.
8. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC12.
♦ Bidirectional-Uncheck for this circuit.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this box if you want to apply the state chosen in the State field to
the circuit source and destination ports. CTC applies the circuit state to the ports only if the
NTP-D83 Create a Unidirectional Low-Order VC12 Circuit with Multiple Drops
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circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog
box shows the ports where the circuit state could not be applied. If the box is unchecked,
CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Check this box if you want the circuit routed to protect drops only, that is,
to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC
displays only protected cards as source and destination choices.
9. Click Next.
10. Complete the "DLP-D95 Provision a Low-Order VC12 Circuit Source and Destination" task.
11. In the Circuit Routing Preferences area, uncheck Route Automatically. When Route Automatically
is not selected, the Using Required Nodes/Spans and Review Route Before Circuit Creation check
boxes are unavailable.
12. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 13. Fully protected paths might or might not have SNCP path
segments (with primary and alternate paths), and the path diversity options apply
only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 16.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, and then continue with Step 16.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted
during MS-SPRing switches.
13. If you selected Fully Protected Path in Step 12 and the circuit will be routed on an SNCP, choose one
of the following:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within the
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
14. If you selected Fully Protected Path in Step 12 and the circuit will be routed on an SNCP DRI, click
the Dual Ring Interconnect check box.
15. Click Next. In the VC LO Matrix Optimization page, choose one of the following:
⋅ Create VC LO tunnel on transit nodes-This option is available if the VC12 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC12 circuits to pass through ONS
15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
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⋅ Create VC LO aggregation point-This option is available if you are creating a VC12
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto an VC4 for
transport outside the ONS 15454 SDH network, choose one of the following:
♦ VC4 grooming node is source-node, VC12 grooming node is
destination-node-Creates the LAP on the VC12 circuit source node. This
option is available only if the VC12 circuit originates on an STM-N card.
♦ VC4 grooming node is destination-node, VC12 grooming node is
source-node-Creates the LAP on the VC12 circuit destination node. This
option is available only if the VC12 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
16. Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit
manually. The circuit source node is selected. Green arrows pointing from the source node to other
network nodes indicate spans that are available for routing the circuit.
17. Complete the "DLP-D3 Provision a Low-Order VC12 Circuit Route" task for the VC12 circuit you
are creating.
18. Click Finish. CTC completes the circuit and the Circuits window appears.
19. In the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit,
and Search buttons become active.
20. Click Edit (or double-click the circuit row). The Edit Circuit window appears with the General tab
selected.
All nodes in the DCC network appear on the network. Circuit source and destination
information appears under the source and destination nodes. To see a detailed view
of the circuit, click Show Detailed Map. To rearrange a node icon, select the node,
press Ctrl, then drag and drop the icon to the new location.
21. In the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.
22. Click Create.
23. In the Define New Drop dialog box, create the new drop:
1. Node-Choose the target node for the circuit drop.
2. Slot-Choose the target card and slot.
3. Port, VC4, VC3/TUG3, TUG2, VC12-Choose the Port, VC4, VC3/TUG3, TUG2, or VC12
from the Port, VC4, VC3/TUG3, TUG2, or VC12 drop-down lists. The card selected in Step
b determines the fields that appear. See Table 6-3 for a list of options.
4. The routing preferences for the new drop match those of the original circuit. However, you
can modify the following:
◊ If the original circuit was routed on a protected SNCP path, you can
change the nodal diversity options: Nodal Diversity Required, Nodal
Diversity Desired, or Link Diversity Only. See Step 13 for
descriptions.
◊ If the original circuit was not routed on a protected path, the
Protection Channel Access option is available. See Step 12 for a
description of the Protection Channel Access option.
5. Click OK. The new drop appears in the Drops list.
24. If you need to create additional drops for the circuit, repeat Steps 22 and 23 to create the additional
drops.
25. Click Close. The Circuits window appears.
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26. Verify that the new drops appear in the Destination column for the circuit that you edited. If they do
not appear, repeat Steps 5 through 25, making sure that all options are provisioned correctly.
27. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.

NTP-D54 Create an Automatically Routed Low-Order VC3 Circuit
Purpose
Tools/Equipment
Prerequisite
Procedures

This procedure creates an automatically routed low-order VC3 circuit, meaning that
CTC chooses the circuit route based on the parameters you specify and on the
software version.
XC-VXL-10G or XC-VXL-2.5G cards must be installed at the circuit source and
destination nodes.
NTP-D127 Verify Network Turn-Up
XC-VXL-10G or XC-VXL-2.5G cards must be installed at the circuit source and
destination nodes.

Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. On the shelf graphic, verify that XC-VXL-10G or XC-VXL-2.5G cross-connect cards are installed in
Slots 8 and 10.
3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Size-Choose VC3.
♦ Number of Circuits-Enter the number of VC3 circuits that you want to create. The default is
1. If you are creating multiple circuits with the same slot and consecutive port numbers, you
can use Auto-ranged to create the circuits automatically.
7. Click Next.
8. Define the circuit attributes (Figure 6-5):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Auto-ranged-This check box is automatically selected if you enter more than 1 in the
Number of Circuits field. Auto-ranging creates identical (same source and destination),
sequential circuits automatically. Uncheck the box if you do not want CTC to create
sequential circuits automatically.
NTP-D54 Create an Automatically Routed Low-Order VC3 Circuit
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♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this check box if you want to apply the state chosen in the State
field to the circuit source and destination ports. CTC applies the circuit state to the ports only
if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger
than the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning
dialog box shows the ports where the circuit state could not be applied. If the box is
unchecked, CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Select this check box if you want the circuit routed on protected drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you select this
check box, CTC displays only protected cards and ports as source and destination choices.
Figure 6-5: Setting Circuit Attributes For a Low-Order VC3 Circuit

9. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task. Otherwise, continue with Step 10.
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10. Click Next.
11. Complete the "DLP-D318 Provision a Low-Order VC3 Circuit Source and Destination" task.
12. In the Circuit Routing Preferences area (Figure 6-2), choose Route Automatically. Two options are
available; choose either, both, or none based on your preferences.
⋅ Using Required Nodes/Spans-Check this check box if you want to specify nodes and
spans to include or exclude in the CTC-generated circuit route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
⋅ Review Route Before Creation-Check this check box if you want to review and edit
the circuit route before the circuit is created.
13. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 14. CTC creates a fully protected circuit route based on the path
diversity option you choose. Fully protected paths might or might not have SNCP
path segments (with primary and alternate paths), and the path diversity options
apply only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 16.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, and then continue with Step 16.
Caution! Circuits routed on MS-SPRing protection channels are not protected. They are preempted
during MS-SPRing switches.
14. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP, choose one
of the following:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
15. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP DRI, click
the Dual Ring Interconnect check box.
16. If you selected Using Required Nodes/Spans in Step 12, complete the following substeps. If not,
continue with Step 18.
1. Click Next.
2. In the Circuit Route Constraints For Auto Routing area, click a node or span on the circuit
map.
3. Click Include to include the node or span in the circuit. Click Exclude to exclude the node
or span from the circuit. The order in which you choose included nodes and spans is the
order in which the circuit is routed. Click spans twice to change the circuit direction.
4. Repeat SubStep 3 for each node or span that you wish to include or exclude.
5. Review the circuit route. To change the circuit routing order, choose a node from the
Required Nodes/Lines or Excluded Nodes Links lists and click the Up or Down buttons to
change the circuit routing order. Click Remove to remove a node or span.
17. Click Next. In the VC LO Matrix Optimization page, choose one of the following:
Figure 6-5: Setting Circuit Attributes For a Low-Order VC3 Circuit
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⋅ Create VC LO tunnel on transit nodes-This option is available if the VC3 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC3 circuits to pass through ONS
15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
⋅ Create VC LO aggregation point-This option is available if you are creating a VC3
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto an VC4 for
transport outside the ONS 15454 SDH network, choose one of the following:
♦ VC4 grooming node is source-node, VC12 grooming node is
destination-node-Creates the LAP on the VC3 circuit source node. This
option is available only if the VC3 circuit originates on an STM-N card.
♦ VC4 grooming node is destination-node, VC12 grooming node is
source-node-Creates the LAP on the VC12 circuit destination node. This
option is available only if the VC3 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
18. If you selected Review Route Before Creation in Step 12, complete the following substeps. If not,
continue with Step 19.
1. Click Next.
2. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route.
Blue arrows show the circuit route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned circuit does not reflect the routing and configuration you want, click Back
to verify and change circuit information. If the circuit needs to be routed to a different path,
see the NTP-D55 Create a Manually Routed Low-Order VC3 Circuit.
19. Click Finish. One of the following results occurs, depending on the circuit properties you chose in
the Circuit Creation dialog box:
⋅ If you entered more than 1 in the Number of Circuits field and selected Auto-ranged,
CTC automatically creates the number of circuits entered in the Number of Circuits
field. If auto-ranging cannot complete all the circuits, for example, because
sequential ports are unavailable at the source or destination, a dialog box appears.
Set the new source or destination for the remaining circuits, then click Finish to
continue auto-ranging. After completing the circuits, the Circuits window appears.
⋅ If you entered more than 1 in the Number of Circuits field and did not choose
Auto-ranged, the Circuit Creation dialog box appears so you can create the
remaining circuits. Repeat Steps 6 through 18 for each additional circuit. After
completing the circuits, the Circuits window appears.
20. In the Circuits window, verify that the new circuits appear in the circuits list.
21. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.

NTP-D55 Create a Manually Routed Low-Order VC3 Circuit
Purpose

This procedure creates low-order VC3 circuit and allows you to provision the
circuit route.

Tools/Equipment
NTP-D55 Create a Manually Routed Low-Order VC3 Circuit
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XC-VXL-10G or XC-VXL-2.5G cards must be installed at the circuit source and
destination nodes.
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. On the shelf graphic, verify that XC-VXL-10G or XC-VXL-2.5G cross-connect cards are installed in
Slots 8 and 10.
3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Number of Circuits-Enter the number of VC3 circuits that you want to create. The default is
1. If you are creating multiple circuits with the same slot and consecutive port numbers, you
can use Auto-ranged to create the circuits automatically.
♦ Auto-ranged-This check box is automatically selected if you enter more than 1 in the
Number of Circuits field. Auto-ranging creates identical (same source and destination),
sequential circuits automatically. Uncheck the box if you do not want CTC to create
sequential circuits automatically.
7. Click Next.
8. Define the circuit attributes (Figure 6-5):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC3.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
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For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Select this check box if you want to apply the state chosen in the State
field to the circuit source and destination ports. CTC applies the circuit state to the ports only
if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger
than the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning
dialog box shows the ports where the circuit state could not be applied. If the box is
unchecked, CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Select this check box if you want the circuit routed on protected drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you select this
check box, CTC displays only protected cards and ports as source and destination choices.
9. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task. Otherwise, continue with Step 10.
10. Click Next.
11. Complete the "DLP-D318 Provision a Low-Order VC3 Circuit Source and Destination" task.
12. In the Circuit Routing Preferences area (Figure 6-2), uncheck Route Automatically.
13. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 14. Fully protected paths might or might not have SNCP path
segments (with primary and alternate paths), and the path diversity options apply
only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 17.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, then continue with Step 17.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted
during MS-SPRing switches.
14. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP, choose a
Node-Diverse Path option:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within the
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired- Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
15. If you selected Fully Protected Path in Step 13 and the circuit will be routed on an SNCP DRI, click
the Dual Ring Interconnect check box.
16. Click Next. In the VC LO Matrix Optimization page, choose one of the following:
⋅ Create VC LO tunnel on transit nodes-This option is available if the VC3 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC3 circuits to pass through ONS
NTP-D55 Create a Manually Routed Low-Order VC3 Circuit
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15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
⋅ Create VC LO aggregation point-This option is available if you are creating a VC3
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto an VC4 for
transport outside the ONS 15454 SDH network, choose one of the following:
♦ VC4 grooming node is source-node, VC12 grooming node is
destination-node-Creates the LAP on the VC3 circuit source node. This
option is available only if the VC3 circuit originates on an STM-N card.
♦ VC4 grooming node is destination-node, VC3 grooming node is
source-node-Creates the LAP on the VC3 circuit destination node. This
option is available only if the VC3 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
17. Click Next. In the Route Review and Edit area, node icons appear for you to route the circuit. The
circuit source node is selected. Green arrows pointing from the source node to other network nodes
indicate spans that are available for routing the circuit.
18. Complete the "DLP-D96 Provision a Low-Order VC3 Circuit Route" task for the VC3 circuit you are
creating.
19. Click Finish. CTC compares your manually provisioned circuit route with the specified path
diversity option you chose in Step 14. If the path does not meet the specified path diversity
requirement, CTC displays an error message and allows you to change the circuit path.
20. If you entered more than 1 in the Number of Circuits field, the Circuit Creation dialog box appears so
you can create the remaining circuits. Repeat Steps 6 through 19 for each additional circuit.
21. When all the circuits are created, the main Circuits window appears. Verify that the circuits you
created are correct.
22. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.

NTP-D56 Create a Unidirectional Low-Order VC3 Circuit with
Multiple Drops
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates a unidirectional low-order VC3 circuit with multiple drops
(destinations).
XC-VXL-10G or XC-VXL-2.5G cards must be installed at the circuit source and
destination nodes.
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
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2. On the shelf graphic, verify that XC-VXL-10G or XC-VXL-2.5G cross-connect cards are installed in
Slots 8 and 10.
3. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
4. From the View menu, choose Go to Network View.
5. Click the Circuits tab, then click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default unchanged (1).
♦ Auto-ranged-Unavailable when the Number of Circuits field is 1.
7. Click Next.
8. Define the circuit attributes (Figure 6-6):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters,
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC3.
♦ Bidirectional-Uncheck for this circuit.
♦ Number of Circuits-Leave the default unchanged (1).
♦ Auto-ranged-Unavailable when the Number of Circuits field is 1.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this box if you want to apply the state chosen in the State field to
the circuit source and destination ports. CTC applies the circuit state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog
box shows the ports where the circuit state could not be applied. If the box is unchecked,
CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Check this box if you want the circuit routed to protect drops only, that is,
to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC
NTP-D56 Create a Unidirectional Low-Order VC3 Circuit with Multiple Drops
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displays only protected cards as source and destination choices.
Figure 6-6: Setting Circuit Attributes for a Unidirectional Low-Order VC3 Circuit

9. Click Next.
10. Complete the "DLP-D318 Provision a Low-Order VC3 Circuit Source and Destination" task.
11. In the Circuit Routing Preferences area, uncheck Route Automatically. When Route Automatically
is not selected, the Using Required Nodes/Spans and Review Route Before Circuit Creation check
boxes are unavailable.
12. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 13. Fully protected paths might or might not have SNCP path
segments (with primary and alternate paths), and the path diversity options apply
only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 16.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, then continue with Step 16.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted
during MS-SPRing switches.
13. If you selected Fully Protected Path in Step 12 and the circuit will be routed on an SNCP, choose one
of the following:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within the
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
14. If you selected Fully Protected Path in Step 12 and the circuit will be routed on an SNCP DRI, click
the Dual Ring Interconnect check box.
15. Click Next. In the VC LO Matrix Optimization page, choose one of the following:

Figure 6-6: Setting Circuit Attributes for a Unidirectional Low-Order VC3 Circuit
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⋅ Create VC LO tunnel on transit nodes-This option is available if the VC3 circuit
passes through a node that does not have a low-order tunnel, or if an existing
low-order tunnel is full. Low-order tunnels allow VC3 circuits to pass through ONS
15454 SDHs without consuming low-order cross-connect card resources. Creating
low-order tunnels is a good idea if you are creating many low-order circuits from the
same source and destination. Refer to the Cisco ONS 15454 SDH Reference Manual
for more information.
⋅ Create VC LO aggregation point-This option is available if you are creating a VC3
circuit to an STM-N port for handoff to non-ONS 15454 SDH networks or
equipment, such as an IOF, switch, or DACS. A LAP allows low-order circuits to be
routed through a node using one VC4 connection on the cross-connect card
high-order matrix rather than multiple connections on the low-order matrix. If you
want to aggregate the low-order circuit you are creating with others onto an VC4 for
transport outside the ONS 15454 SDH network, choose one of the following:
♦ VC4 grooming node is source-node, VC12 grooming node is
destination-node-Creates the LAP on the VC3 circuit source node. This
option is available only if the VC3 circuit originates on an STM-N card.
♦ VC4 grooming node is destination-node, VC12 grooming node is
source-node-Creates the LAP on the VC3 circuit destination node. This
option is available only if the VC3 circuit terminates on an STM-N card.
⋅ None-Choose this option if you do not want to create a low-order tunnel or a LAP.
This is the only available option if CTC cannot create a low-order tunnel or LAP.
16. Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit
manually. The circuit source node is selected. Green arrows pointing from the source node to other
network nodes indicate spans that are available for routing the circuit.
17. Complete the "DLP-D96 Provision a Low-Order VC3 Circuit Route" task for the VC3 circuit you are
creating.
18. Click Finish. The Circuits window appears.
19. In the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit,
and Search buttons become active.
20. Click Edit (or double-click the circuit row). The Edit Circuit window appears with the General tab
selected.
All nodes in the DCC network appear on the network. Circuit source and destination
information appears under the source and destination nodes. To see a detailed view
of the circuit, click Show Detailed Map. To rearrange a node icon, select the node,
press Ctrl, then drag and drop the icon to the new location.
21. In the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.
22. Click Create.
23. In the Define New Drop dialog box, create the new drop:
1. Node-Choose the target node for the circuit drop.
2. Slot-Choose the target card and slot.
3. Port, VC4, or VC3-Choose the Port, VC4, or VC3 from the Port, VC4, or VC3 drop-down
lists. The card selected in Step b determines the fields that appear. See Table 6-3 for a list of
options.
4. The routing preferences for the new drop match those of the original circuit. However, you
can modify the following:
◊ If the original circuit was routed on a protected SNCP path, you can
change the nodal diversity options: Nodal Diversity Required, Nodal
Diversity Desired, or Link Diversity Only. See Step 13 for
descriptions.
◊ If the original circuit was not routed on a protected path, the
Protection Channel Access option is available. See Step 12 for a
Figure 6-6: Setting Circuit Attributes for a Unidirectional Low-Order VC3 Circuit
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description of the Protection Channel Access option.
5. Click OK. The new drop appears in the Drops list.
24. If you need to create additional drops for the circuit, repeat Steps 22 and 23 to create the additional
drops.
25. Choose Close. The Circuits window appears.
26. Verify that the new drops appear in the Destination column for the circuit that you edited. If they do
not appear, repeat Steps 5 through 25, making sure that all options are provisioned correctly.
27. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.

NTP-D133 Create an Automatically Routed Low-Order Tunnel
Purpose

This procedure creates an automatically routed low-order tunnel from source to
destination nodes.
None

Tools/Equipment
Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As Needed As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
Note: Low-order tunnels allow low-order VC12 and VC3 circuits to pass through intermediary ONS 15454
SDH nodes without consuming low-order matrix resources on the cross-connect card. In general, creating
low-order tunnels is a good idea if you are creating many low-order circuits from the same source and
destination. Refer to the "Circuits and Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual for
more information.
1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the tunnel. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the tunnel source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. From the View menu, choose Go to Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH TUNNEL.
♦ For VC3 Port Grouping Only-Leave this box unchecked.
6. Click Next.
7. Define the circuit attributes (Figure 6-7):
♦ Name-Assign a name to the low-order tunnel. The name can be alphanumeric and up to 48
characters (including spaces). Circuit names should be 44 characters or less if you want the
ability to create monitor circuits. If you leave the field blank, CTC assigns a default name to
the tunnel.
♦ Size-The default size is VC4. You cannot change this value.
♦ Bidirectional-The default is Bidirectional. You cannot change this value.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
NTP-D133 Create an Automatically Routed Low-Order Tunnel
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◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
Note: A low-order tunnel automatically transitions into the Unlocked service state after a
VC12 or VC3 circuit is created.
• For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
◊ Apply to drop ports-Unavailable for low-order tunnels.
Figure 6-7: Setting Attributes for a Low-Order Tunnel

8. Click Next.
9. In the Circuit Source area, choose the node where the low-order tunnel will originate from the Node
drop-down list.
10. Click Next.
11. In the Circuit Destination area, choose the node where the low-order tunnel will terminate from the
Node drop-down list.
12. Click Next.
13. In the Circuit Routing Preferences area, choose Route Automatically. Two options are available;
choose either, both, or none based on your preferences.
⋅ Using Required Nodes/Spans-Check this check box to specify nodes and spans to
include or exclude in the CTC-generated tunnel route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
Figure 6-7: Setting Attributes for a Low-Order Tunnel
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ensures that the nodes and spans are not in the working or protect path of the circuit.
⋅ Review Route Before Creation-Check this check box to review and edit the
low-order tunnel route before the circuit is created.
14. If you selected Using Required Nodes/Spans in Step 13:
1. Click Next.
2. In the Circuit Route Constraints For Auto Routing area, click a span on the low-order tunnel
map.
3. Click Include to include the node or span in the low-order tunnel. Click Exclude to exclude
the node or span from the low-order tunnel. The order in which you choose included nodes
and spans sets the low-order tunnel sequence. Click spans twice to change the circuit
direction.
4. Repeat SubStep 3 for each node or span that you wish to include or exclude.
5. Review the low-order tunnel route. To change the tunnel routing order, choose a node from
the Required Nodes/Lines or Excluded Nodes Links lists, then click the Up or Down buttons
to change the tunnel routing order. Click Remove to remove a node or span.
15. If you selected Review Route Before Creation in Step 13:
1. Click Next.
2. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route.
Blue arrows show the tunnel route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned tunnel does not reflect the routing and configuration you want, click Back
to verify and change the tunnel information.
16. Click Finish. The Circuits window appears.
17. Verify that the tunnel you just created appears in the circuits list. Low-order tunnels are identified by
LOT in the Type column.
Stop. You have completed this procedure.

NTP-D134 Create a Manually Routed Low-Order Tunnel
Purpose

This procedure creates a manually routed, low-order tunnel from source to
destination nodes.
None

Tools/Equipment
Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As Needed As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: Low-order tunnels allow low-order circuits to pass through intermediary ONS 15454 SDHs without
consuming low-order matrix resources on the cross-connect card. In general, creating low-order tunnels is a
good idea if you are creating many low-order circuits from the same source and destination. Refer to the
"Circuits and Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual for more information.
1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the tunnel. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the tunnel source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 4.
3. From the View menu, choose Go to Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, complete the following fields:
NTP-D134 Create a Manually Routed Low-Order Tunnel
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♦ Circuit Type-Choose VC_LO_PATH TUNNEL.
♦ For VC3 Port Grouping Only-Leave this box unchecked.
6. Click Next.
7. Define the circuit attributes (Figure 6-8):
♦ Name-Assign a name to the low-order tunnel. The name can be alphanumeric and up to 48
characters (including spaces). Circuit names should be 44 characters or less if you want the
ability to create monitor circuits. If you leave the field blank, CTC assigns a default name to
the tunnel.
♦ Size-The default size is VC4. You cannot change this value.
♦ Bidirectional-Unavailable for low-order tunnels.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
Note: A low-order tunnel automatically transitions into the Unlocked service state after a
VC12 or VC3 circuit is created.
For additional information about circuit service states, refer to the "Circuits and Tunnels"
chapter in the Cisco ONS 15454 SDH Reference Manual.
◊ Apply to drop ports-Unavailable for low-order tunnels.
8. Click Next.
9. In the Circuit Source area, choose the node where the low-order tunnel will originate from the Node
drop-down list.
10. Click Next.
11. In the Circuit Destination area, choose the node where the low-order tunnel will terminate from the
Node drop-down list.
12. Click Next.
13. In the Circuit Routing Preferences area, uncheck Route Automatically. When Route Automatically
is not selected, the Using Required Nodes/Spans and Review Route Before Circuit Creation check
boxes are unavailable.
14. Click Next. In the Route Review and Edit area, node icons appear for tunnel routing. The circuit
source node is selected. Green arrows pointing from the source node to other network nodes indicate
spans that are available for routing the tunnel.
15. Complete the "DLP-D219 Provision a Low-Order Tunnel Route" task for the tunnel you are creating.
The Circuits window appears.
16. Verify that the tunnel you just created appears in the circuits list. Low-order tunnels are identified by
LOT in the Type column.
Stop. You have completed this procedure.
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NTP-D216 Create a Low-Order Path Tunnel for Port Grouping
Purpose

This procedure creates a low-order path tunnel for the E3 and DS3i-N-12 cards. Port
group tunnels can be used to transport VC3 signal rates.
None

Tools/Equipment
Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As Needed As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the tunnel. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the tunnel source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. From the View menu, choose Go to Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_LO_PATH TUNNEL.
♦ For VC3 Port Grouping Only-Check this box.
6. Click Next.
7. Define the circuit attributes:
♦ Name-Assign a name to the low-order tunnel. The name can be alphanumeric and up to 48
characters (including spaces). Circuit names should be 44 characters or less if you want the
ability to create monitor circuits. If you leave the field blank, CTC assigns a default name to
the tunnel.
♦ Size-The default size is VC4. You cannot change this value.
♦ Bidirectional-This check box is automatically checked.
Three ports form one port group. For example, in one E3 or one DS3i-N-12 card, there are four port groups:
• Ports 1 to 3 = PG1
• Ports 4 to 6 = PG2
• Ports 7 to 9 = PG3
• Ports 10 to 12 = PG4
Low-order path tunneling is performed at the VC3 level.
◊ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
• Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
• Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
• Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
• Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
NTP-D216 Create a Low-Order Path Tunnel for Port Grouping
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traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
Note: A low-order tunnel automatically transitions into the Unlocked service state after a
VC12 or VC3 circuit is created.
For additional information about circuit service states, refer to the "Circuits and Tunnels"
chapter in the Cisco ONS 15454 SDH Reference Manual.
◊ Apply to drop ports-Uncheck this box.
8. If the tunnel will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task. Otherwise, continue with Step 9.
9. Click Next.
10. In the Circuit Source area, choose the node where the low-order tunnel will originate from the Node
drop-down list. Complete the following:
1. From the Slot drop-down list, choose the slot containing the card where the circuit will
originate.
2. For optical circuits, choose the VC4 from the VC4 drop-down list.
3. For electrical circuits on E3 or DS3i-N-12 cards, choose the port group from the Port Group
drop-down list.
4. Click Next.
11. In the Circuit Destination area, choose the node where the low-order tunnel will terminate from the
Node drop-down list. Complete the following:
1. From the Slot drop-down list, choose the slot containing the card where the circuit will
terminate.
2. For optical circuits, choose the VC4 from the VC4 drop-down list.
3. For electrical circuits on E3 or DS3i-N-12 cards, choose the port group from the Port Group
drop-down list.
4. Click Next.
12. In the Circuit Routing Preferences area, choose Route Automatically. Two options are available;
choose either, both, or none based on your preferences.
⋅ Using Required Nodes/Spans-Check this check box to specify nodes and spans to
include or exclude in the CTC-generated tunnel route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
⋅ Review Route Before Creation-Select this check box to review and edit the
low-order tunnel route before the circuit is created.
13. If you selected Using Required Nodes/Spans in Step 12:
1. Click Next.
2. In the Circuit Route Constraints For Auto Routing area, click a span on the low-order tunnel
map.
3. Click Include to include the node or span in the low-order tunnel. Click Exclude to exclude
the node or span from the low-order tunnel. The order in which you choose included nodes
and spans sets the low-order tunnel sequence. Click spans twice to change the circuit
direction.
4. Repeat SubStep 3 for each node or span that you wish to include or exclude.
5. Review the low-order tunnel route. To change the tunnel routing order, choose a node from
the Required Nodes/Lines or Excluded Nodes Links lists, then click the Up or Down buttons
to change the tunnel routing order. Click Remove to remove a node or span.
14. If you selected Review Route Before Creation in Step 12:
NTP-D216 Create a Low-Order Path Tunnel for Port Grouping
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1. Click Next.
2. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route.
Blue arrows show the tunnel route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned tunnel does not reflect the routing and configuration you want, click Back
to verify and change the tunnel information.
15. Click Finish. The Circuits window appears.
16. Verify that the tunnel you just created appears in the circuits list. Low-order tunnels are identified by
LOT in the Type column.
Stop. You have completed this procedure.

NTP-D187 Create a Low-Order Aggregation Point
Purpose

This procedure creates a low-order aggregation point (LAP). LAPs allow multiple VC3
or VC12 low-order circuits to be aggregated on a single VC4 circuit. LAPs allow
multiple low-order circuits to pass through cross-connect cards without utilizing
resources on the cross-connect card low-order matrix.
None

Tools/Equipment
Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
Note: You can create low-order aggregation points for circuits in MS-SPRing or 1+1 protection, or for
unprotected circuits. You cannot create them for SNCP ring circuits.
Note: The maximum number of LAPs that you can create depends on the node protection topology and the
number of low-order circuits that terminate on the node. Assuming that no other low-order circuits terminate
at the node, the maximum number of LAPs that you can terminate at one node is 8 for 1+1 and 12 for
MS-SPRing protection.
1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the LAP. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the tunnel source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. From the View menu, choose Go to Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, choose VC_LO_PATH_AGGREGATION.
6. Click Next.
7. Define the circuit attributes (Figure 6-8):
♦ Name-Assign a name to the low-order aggregation point. The name can be alphanumeric and
up to 48 characters (including spaces). Circuit names should be 44 characters or less if you
want the ability to create monitor circuits. If you leave the field blank, CTC assigns a default
NTP-D187 Create a Low-Order Aggregation Point
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name to the LAP.
♦ Size-Defaults to VC4. You cannot change the value.
♦ Bidirectional-Defaults to Bidirectional. You cannot change the value.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
Note: A low-order aggregation point automatically transitions into the Unlocked service
state after a VC12 or VC3 circuit is created.
For additional information about circuit service states, refer to the "Circuits and Tunnels"
chapter in the Cisco ONS 15454 SDH Reference Manual.
◊ Apply to drop ports-Uncheck this box.
Figure 6-8: Setting Attributes for a Low-Order Aggregation Point

Note: LAPs cannot be routed on an SNCP ring, so the SNCP path selectors do not apply.
8. Click Next.
9. In the Circuit Source area, choose the source node, slot, port, and VC4 for the LAP. The LAP source
is where the low-order circuits are aggregated into a single VC4. The LAP destination is where the
low-order circuits originate.
1. From the Node drop-down list, choose the node where the LAP will originate.
2. From the Slot drop-down list, choose the slot containing the STM-N, E3-12, DS3i-N-12, or
STM1E-12 card where the LAP will originate.
3. Depending on the card chosen in SubStep 2, choose the port and/or VC4 from the Port and
VC4 drop-down lists.
Figure 6-8: Setting Attributes for a Low-Order Aggregation Point
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10. Click Next.
11. In the Circuit Destination area, choose the node where the low-order circuits aggregated by the LAP
will terminate from the Node drop-down list.
12. Click Next.
13. In the Circuit Routing Preferences area, choose Route Automatically. Two options are available;
choose either, both, or none based on your preferences.
⋅ Using Required Nodes/Spans-Check this check box to specify nodes and spans to
include or exclude in the CTC-generated tunnel route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
⋅ Review Route Before Creation-Check this check box to review and edit the
low-order tunnel route before the circuit is created.
14. If you selected Using Required Nodes/Spans in Step 13:
1. Click Next.
2. In the Circuit Route Constraints For Auto Routing area, click a span on the LAP map.
3. Click Include to include the node or span in the LAP. Click Exclude to exclude the node or
span from the LAP. The sequence in which you choose the nodes and spans sets the LAP
sequence. Click spans twice to change the circuit direction.
4. Repeat SubStep 3 for each node or span that you wish to include or exclude.
5. Review the LAP route. To change the tunnel routing order, choose a node from the Required
Nodes/Lines or Excluded Nodes Links lists, then click the Up or Down buttons to change
the tunnel routing order. Click Remove to remove a node or span.
15. If you selected Review Route Before Creation in Step 13:
1. Click Next.
2. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route.
Blue arrows show the tunnel route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned tunnel does not reflect the routing and configuration you want, click Back
to verify and change the tunnel information.
16. Click Finish. The Circuits window appears.
17. Verify that the LAP you just created appears in the circuits list. LAPs are identified in the Type
column.
Stop. You have completed this procedure.

NTP-D135 Test Low-Order Circuits
Purpose
Tools/Equipment
Prerequisite
Procedures

This procedure tests low-order VC11, VC12, and VC3 circuits.
A test set and all appropriate cables
This procedure assumes that you completed facility loopback tests on the fibers and
cables from the source and destination ONS 15454 SDHs to the digital signal
cross-connect (DSX), and that you created a circuit using one of the following
procedures:
NTP-D334 Create an Automatically Routed Low-Order VC11 Circuit
NTP-D335 Create a Manually Routed Low-Order VC11 Circuit
NTP-D336 Create a Unidirectional Low-Order VC11 Circuit with Multiple Drops
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NTP-D81 Create an Automatically Routed Low-Order VC12 Circuit
NTP-D82 Create a Manually Routed Low-Order VC12 Circuit
NTP-D83 Create a Unidirectional Low-Order VC12 Circuit with Multiple Drops
NTP-D54 Create an Automatically Routed Low-Order VC3 Circuit
NTP-D55 Create a Manually Routed Low-Order VC3 Circuit
NTP-D56 Create a Unidirectional Low-Order VC3 Circuit with Multiple Drops
Required/As
Needed
Onsite/Remote
Security Level

Required
Onsite
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
test the circuit. If you are already logged in, continue with Step 2.
2. From the View menu, choose Go to Network View.
3. Click the Circuit tab.
4. Complete the "DLP-D230 Change a Circuit State" task and set the circuit ports to the
Locked-enabled,maintenance service state. Take note of the original state because you will return the
circuit to that state later.
5. Attach loopback cables to the circuit destination card.
1. Verify the integrity of the loopback cable by looping the test set transmit (Tx) connector to
the test set receive (Rx) connector. If the test set does not run error-free, check the cable for
damage and check the test set to make sure it is set up correctly before going to SubStep 2.
2. Attach the loopback cable to the port you are testing. Connect the Tx connector to the Rx
connector of the port.
6. Attach loopback cables to the circuit source node.
1. Verify the integrity of loopback cable by looping the test set Tx connector to the test set Rx
connector. If the test set does not run error-free, check the cable for damage and check the
test set to make sure it is set up correctly before going to SubStep 2.
2. Attach the loopback cable to the port you are testing. Connect the test set to the circuit
source port. Connect the Tx port of the test set to the circuit Rx port and the test set Rx port
to the circuit Tx port.
7. Configure the test set for the ONS 15454 SDH card that is the source of the circuit you are testing:
♦ VC4 or VC4-nc-If you are testing a VC4 circuit or a VC4-nc circuit on an STM-N card, you
must have a direct optical interface into the ONS 15454 SDH. Set the test set for STM-N.
For information about configuring your test set, consult your test set user guide.
♦ VC3-If you are testing a clear channel E3/DS3i-N-12, you must have a patch panel or a
direct E3/DS3i-N-12 interface into the ONS 15454 SDH. Set the test set for clear channel
E3/DS3i-N-12. For information about configuring your test set, consult your test set user
guide.
♦ VC12-If you are testing an E1, you must have a patch panel or a direct E1 interface to the
ONS 15454 SDH. Set the test set for E1. For information about configuring your test set,
consult your test set user guide.
8. Verify that the test set has a clean signal. If a clean signal is not shown, repeat Steps 4 through 7 to
make sure the test set and cabling are configured correctly.
9. Inject errors from the test set. Verify that the errors appear at the source and destination nodes.
10. Clear the performance monitoring (PM) counts for the ports that you tested. See the "DLP-D459
Clear Selected PM Counts" task for instructions.
NTP-D135 Test Low-Order Circuits
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11. Complete the "DLP-D230 Change a Circuit State" task and put the circuit and circuit ports back to
the state they were in at the beginning of the test.
12. Perform the protection switch test appropriate to the SDH topology:
♦ For SNCP rings, complete the "DLP-D94 SNCP Protection Switching Test" task
♦ For MS-SPRings complete the "DLP-D91 MS-SPRing Switch Test" task.
13. Perform a bit error rate test (BERT) for 12 hours or follow your site requirements for length of time.
For information about configuring your test set for BERT, see your test set user guide.
14. After the BERT is complete, print the results or save them to a disk for future reference. For
information about printing or saving test results, see your test set user guide.
Stop. You have completed this procedure.

NTP-D323 Create an Automatically Routed High-Order Circuit
Purpose

Tools/Equipment

This procedure creates an automatically routed bidirectional or unidirectional
high-order circuit, including VC4 and concatenated VC4-2c, VC4-3c, VC4-4c,
VC4-8c, VC4-16c, and VC4-64c speeds.
STM-N cards and all Ethernet cards, except E-Series cards.
For a G-Series circuit, a G-Series card or ML-Series card must be installed at the other
end of the circuit.

Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 6.
3. If you are creating a circuit on G-Series cards, complete the "DLP-D222 Provision G-Series Ethernet
Ports" task before or after you create the G-Series circuit.
4. If you are creating a circuit on ML-Series, CE-100T-8, CE-1000-4, or CE-MR-10 cards, complete
the following as necessary (you can provision Ethernet or packet-over-SDH (POS) ports before or
after the VCAT circuit is created):
♦ To provision Ethernet ports for CE-100T-8 or CE-MR-10 circuits, complete the "DLP-D136
Provision CE-100T-8 and CE-MR-10 Ethernet Ports" task.
♦ To provision Ethernet ports for CE-1000-4 circuits, complete the "DLP-D211 Provision
CE-1000-4 Ethernet Ports" task.
♦ To provision POS ports for CE-Series circuits, complete the "DLP-D141 Provision
CE-100T-8, CE-1000-4, and CE-MR-10 POS Ports" task.
♦ To provision Ethernet ports for ML-Series circuits, complete the "DLP-D493 Provision the
Ethernet Port of the ML-Series Card" task.
♦ To provision POS ports for ML-Series circuits, complete the "DLP-D494 Provision the POS
Port of the ML-Series Card" task.
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5. To provision the card mode for ML-Series cards, complete the "DLP-D213 Provision the Card Mode
for ML-Series Ethernet Cards" task.
6. From the View menu, choose Go to Network View.
7. Click the Circuits tab, then click Create.
8. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Enter the number of high-order circuits that you want to create. The
default is 1. If you are creating multiple circuits with the same source and destination, you
can use auto-ranging to create the circuits automatically.
♦ Auto-ranged-This check box is automatically selected when you enter more than 1 in the
Number of Circuits field. Leave this check box selected if you are creating multiple
high-order circuits with the same source and destination and you want CTC to create the
circuits automatically. Uncheck the box if you do not want CTC to create the circuits
automatically.
9. Click Next.
10. Define the circuit attributes (Figure 6-9):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose the high-order circuit size: VC4, VC4-2c, VC4-3c, VC4-4c, VC4-8c, VC4-9c,
VC4-16c, or VC4-64c. Valid circuit sizes for a G-Series or CE-MR-10 circuit are VC4,
VC4-2c, VC4-3c, VC4-4c, VC4-8c, and VC4-16c.
♦ Bidirectional-Leave checked for this circuit (default).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this box if you want to apply the state chosen in the State field to
the circuit source and destination ports. CTC applies the circuit state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog
box shows the ports where the circuit state could not be applied. If the box is unchecked,
CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
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Unlocked-disabled,failed.
◊ Protected Drops-Select this check box if you want the circuit routed to protected drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you select this
check box, CTC shows only protected cards as source and destination choices.
Figure 6-9: Setting Circuit Attributes for an High-Order Circuit

11. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
12. Click Next.
13. Complete the "DLP-D97 Provision a High-Order Circuit Source and Destination" task for the
high-order circuit you are creating.
14. In the Circuit Routing Preferences area, choose Route Automatically. Two options are available;
choose either, both, or none based on your preferences.
⋅ Using Required Nodes/Spans-Check this check box to specify nodes and spans to
include or exclude in the CTC-generated circuit route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
⋅ Review Route Before Creation-Check this check box to review and edit the circuit
route before the circuit is created.
15. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 16. CTC creates a fully protected circuit route based on the path
diversity option you choose. Fully protected paths might or might not have SNCP
path segments (with primary and alternate paths), and the path diversity options
apply only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 18.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, then continue with Step 18.
16. If you selected Fully Protected Path in Step 15 and the circuit will be routed on SNCP, choose one of
the following:
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⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
17. If you selected Fully Protected Path in Step 15 and the circuit will be routed on an MS-SPRing DRI
or SNCP DRI, check the Dual Ring Interconnect check box. If not, continue with Step 20.
18. If you checked Dual Ring Interconnect for an SNCP in Step 17, complete the following substeps. If
you checked Dual Ring Interconnect for a MS-SPRing, skip this step and continue with Step 19.
1. Click Next.
2. In the Circuit Route Constraints For Auto Routing area, click a node or span on the circuit
map.
3. Click Include to include the node or span in the circuit, or click Exclude to exclude the node
or span from the circuit. The order in which you choose included nodes and spans is the
order in which the circuit is routed. Click spans twice to change the circuit direction.
4. Repeat SubStep 3 for each node or span that you wish to include or exclude.
5. Review the circuit route. To change the circuit routing order, choose a node from the
Required Nodes/Lines or Excluded Nodes Links lists, then click the Up or Down buttons to
change the circuit routing order. Click Remove to remove a node or span.
19. If you checked Dual Ring Interconnect for a MS-SPRing in Step 17, complete the following substeps
to assign primary and secondary nodes and ring type.
1. In the Circuit Constraints for Automatic Routing area, click Add MS-SPRing DRI.
2. In the confirmation window, click OK.
3. In the Node Options area of the MS-SPRing DRI Options dialog box, complete the
following:
• Primary Node-For a traditional or integrated MS-SPRing DRI, choose the
node where the circuit interconnects the rings.
• Secondary Node-For a traditional or integrated MS-SPRing DRI, choose the
secondary node for the circuit to interconnect the rings. This route is used if
the route on the primary node fails.
• Primary Node #2-For a traditional MS-SPRing DRI where two primary
nodes are required to interconnect rings, choose the second primary node.
• Secondary Node #2-For a traditional MS-SPRing DRI where two secondary
nodes are required, choose the second secondary node.
4. In the Ring and Path Options area, complete the following:
• The first ring is-Choose SNCP or MS-SPRing from the drop-down list.
• The second ring is-Choose SNCP or MS-SPRing from the drop-down list.
• Use ring interworking protection (RIP) on secondary path-Check this box to
carry the secondary spans on the protection channels. These spans will be
preempted during a ring/span switch.
5. Click OK. The node information appears in the Required Nodes/Lines list, and the map
graphic indicates which nodes are primary and secondary.
6. In the Circuit Constraints for Automatic Routing area, click a node or span on the circuit
map.
7. Click Include to include the node or span in the circuit, or click Exclude to exclude the node
or span from the circuit. The order in which you choose included nodes and spans is the
order in which the circuit will be routed. Click spans twice to change the circuit direction. If
you are creating an SNCP to MS-SPRing traditional handoff, exclude the unprotected links
Figure 6-9: Setting Circuit Attributes for an High-Order Circuit
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from the primary node towards the secondary node. If you are creating an SNCP to
MS-SPRing integrated handoff, exclude unnecessary DRIs on the SNCP segments.
8. Review the circuit constraints. To change the circuit routing order, choose a node in the
Required Nodes/Lines lists and click the Up or Down buttons to change the circuit routing
order. Click Remove to remove a node or span.
20. If you selected Review Route Before Creation in Step 14, complete the following substeps;
otherwise, continue with Step 22:
1. Click Next.
2. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route.
Blue arrows show the circuit route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned circuit does not reflect the routing and configuration you want, click Back
to verify and change circuit information. If the circuit needs to be routed to a different path,
see the NTP-D324 Create a Manually Routed High-Order Circuit to assign the circuit route
yourself.
21. If you selected Review Route Before Creation in Step 14, click Next. If not, continue with Step 22.
View the route in the Route Review/Edit window. As necessary, click Add MS-SPRing DRI to add
another DRI. Click Remove to remove a DRI assignment. Click the Included Spans tab to view the
spans. The map graphic updates as you apply changes.
22. Click Finish. One of the following occurs, based on the circuit properties that you provisioned in the
Circuit Creation dialog box:
⋅ If you entered more than 1 in the Number of Circuits field and selected Auto-ranged,
CTC automatically creates the number of circuits entered in Number of Circuits. If
auto-ranging cannot complete all the circuits, for example, because sequential ports
are unavailable on the source or destination, a dialog box appears. Set the new
source or destination for the remaining circuits, then click Finish to continue
auto-ranging. After completing the circuits, the Circuits window appears.
⋅ If you entered more than 1 in Number of Circuits and did not choose Auto-ranged,
the Circuit Creation dialog box appears so you can create the remaining circuits.
Repeat Steps 8 through 21 for each additional circuit. After completing the circuits,
the Circuits window appears.
23. In the Circuits window, verify that the circuits you created appear in the circuits list.
24. Complete the following as necessary. Skip this step if you built a test circuit.
1. Complete the NTP-D62 Test High-Order Circuits.
2. Complete the NTP-D149 Test G-Series Circuits.
Stop. You have completed this procedure.

NTP-D324 Create a Manually Routed High-Order Circuit
Purpose

Tools/Equipment
Prerequisite
Procedures
Required/As
Needed

This procedure creates a manually routed, bidirectional or unidirectional high-order
circuit, including VC4 and concatenated VC4-2c, VC4-3c, VC4-4c, VC4-8c,
VC4-16c, and VC4-64c speeds.
STM-N cards and all Ethernet cards, except E-Series cards.
For a G-Series circuit, a G-Series card or ML-Series card must be installed at the other
end of the circuit.
NTP-D127 Verify Network Turn-Up
As needed
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Onsite/Remote
Security Level

Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. If you are creating a circuit on G-Series cards, complete the "DLP-D222 Provision G-Series Ethernet
Ports" task before or after you create the G-Series circuit.
4. If you are creating a circuit on CE-100T-8, CE-1000-4, or CE-MR-10 circuits, complete the
following as necessary (you can provision Ethernet or POS ports before or after the VCAT circuit is
created):
♦ To provision Ethernet ports for CE-100T-8 or CE-MR-10 circuits, complete the "DLP-D136
Provision CE-100T-8 and CE-MR-10 Ethernet Ports" task.
♦ To provision Ethernet ports for CE-1000-4 circuits, complete the "DLP-D211 Provision
CE-1000-4 Ethernet Ports" task.
♦ To provision POS ports for CE-Series circuits, complete the "DLP-D141 Provision
CE-100T-8, CE-1000-4, and CE-MR-10 POS Ports" task.
♦ To provision Ethernet ports for ML-Series circuits, complete the "DLP-D493 Provision the
Ethernet Port of the ML-Series Card" task.
♦ To provision POS ports for ML-Series circuits, complete the "DLP-D494 Provision the POS
Port of the ML-Series Card" task.
5. To provision the card mode for ML-Series cards, complete the "DLP-D213 Provision the Card Mode
for ML-Series Ethernet Cards" task.
6. From the View menu, choose Go to Network View.
7. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Enter the number of high-order circuits that you want to create.
The default is 1.
♦ Auto-ranged-(Applies to automatically routed circuits only) If you entered more than 1 in
Number of Circuits, uncheck this check box. (The check box is unavailable if only one
circuit is entered in Number of Circuits.)
8. Click Next.
9. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose the high-order circuit size: VC4, VC4-2c, VC4-3c, VC4-4c, VC4-8c,
VC4-16c, or VC4-64c. Valid circuit sizes for a G-Series or CE-MR-10 circuit are VC4,
VC4-2c, VC4-3c, VC4-4c, VC4-8c, and VC4-16c.
♦ Bidirectional-Leave checked for this circuit.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
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automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this box if you want to apply the state chosen in the State field to
the circuit source and destination ports. CTC applies the circuit state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog
box shows the ports where the circuit state could not be applied. If the box is unchecked,
CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Select this check box if you want the circuit routed to protect drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you select this
check box, CTC shows only protected cards as source and destination choices.
10. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
11. Click Next.
12. Complete the "DLP-D97 Provision a High-Order Circuit Source and Destination" task for the
high-order circuit you are creating.
13. In the Circuit Routing Preferences area, uncheck Route Automatically.
14. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 15.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 17.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, then continue with Step 17.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted
during MS-SPRing switches.
15. If you selected Fully Protected Path in Step 14 and the circuit will be routed on an SNCP, choose one
of the following:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within the
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
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16. If you selected Fully Protected Path in Step 14 and the circuit will be routed on an MS-SPRing DRI
or SNCP DRI, click the Dual Ring Interconnect check box.
17. Click Next. In the Route Review/Edit area, node icons appear for you to route the circuit manually.
If you checked Dual Ring Interconnect for MS-SPRing, continue with Step 18. If not, continue with
Step 19.
18. If you checked Dual Ring Interconnect in Step 14 for a MS-SPRing DRI, complete the following
substeps to assign primary and secondary nodes.
1. In the Route/Review Edit area, click the MS-SPRing DRI Nodes tab.
2. Click Add MS-SPRing DRI.
3. In the Node Options area of the MS-SPRing DRI Options dialog box, complete the
following:
• Primary Node-For a traditional or integrated MS-SPRing DRI, choose the
node where the circuit interconnects the rings.
• Secondary Node-For a traditional or integrated MS-SPRing DRI, choose the
secondary node for the circuit to interconnect the rings. This route is used if
the route on the primary node fails.
• Primary Node #2-For a traditional MS-SPRing DRI where two primary
nodes are required to interconnect rings, choose the second primary node.
• Secondary Node #2-For a traditional MS-SPRing DRI where two secondary
nodes are required, choose the second secondary node.
4. Click OK.
5. Review the circuit constraints. To change the circuit routing order, choose a node in the
Required Nodes/Lines lists and click the Up or Down buttons to change the circuit routing
order. Click Remove to remove a node or span.
6. Click the Included Spans tab, and continue with Step 19.
19. Complete the "DLP-D98 Provision a High-Order Circuit Route" task.
20. Click Finish. If the path does not meet the specified path diversity requirement, CTC shows an error
message and allows you to change the circuit path. If you entered more than 1 in the Number of
Circuits field, the Circuit Creation dialog box appears after the circuit is created so you can create the
remaining circuits. Repeat Steps 7 through 19 for each additional circuit.
21. When all the circuits are created, the main Circuits window appears. Verify that the circuits you
created appear in the window.
22. Complete the following as necessary. Skip this step if you built a test circuit.
1. Complete the NTP-D62 Test High-Order Circuits.
2. Complete the NTP-D149 Test G-Series Circuits.
Stop. You have completed this procedure.

NTP-D190 Create a Unidirectional High-Order Circuit with Multiple
Drops
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates a unidirectional STM-N circuit with multiple traffic drops
(circuit destinations).
None
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
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2. If you want to assign a name to the tunnel source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. From the View menu, choose Go to Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default unchanged (1).
♦ Auto-ranged-Unavailable when the Number of Circuits field is 1.
6. Click Next.
7. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose the high-order circuit size: VC4, VC4-2c, VC4-3c, VC4-4c, VC4-8c, VC4-9c,
VC4-16c, or VC4-64c.
♦ Bidirectional-Uncheck this check box for this circuit.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this box if you want to apply the state chosen in the State field to
the circuit source and destination ports. CTC applies the circuit state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog
box shows the ports where the circuit state could not be applied. If the box is unchecked,
CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Select this check box if you want the circuit routed to protect drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you select this
check box, CTC shows only protected cards as source and destination choices.
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8. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
9. Click Next.
10. Complete the "DLP-D97 Provision a High-Order Circuit Source and Destination" task for the circuit
you are creating.
11. Uncheck Route Automatically. When Route Automatically is not selected, the Using Required
Nodes/Spans and Review Route Before Circuit Creation check boxes are unavailable.
12. Set the circuit path protection:
⋅ To route the circuit on a protected path, leave Fully Protected Path checked and
continue with Step 13. Fully protected paths might or might not have SNCP path
segments (with primary and alternate paths), and the path diversity options apply
only to SNCP path segments, if any exist.
⋅ To create an unprotected circuit, uncheck Fully Protected Path and continue with
Step 15.
⋅ To route the circuit on an MS-SPRing protection channel, if available, uncheck
Fully Protected Path, check Protection Channel Access, click Yes in the Warning
dialog box, then continue with Step 15.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted
during MS-SPRing switches.
13. If you selected Fully Protected Path in Step 12 and the circuit will be routed on an SNCP, choose one
of the following:
⋅ Nodal Diversity Required-Ensures that the primary and alternate paths within the
SNCP ring portions of the complete circuit path are nodally diverse.
⋅ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node
diversity is not possible, CTC creates fiber-diverse paths for the SNCP ring portion
of the complete circuit path.
⋅ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths
for SNCP ring portions of the complete circuit path are needed. The paths might be
node diverse, but CTC does not check for node diversity.
Note: For manually routed circuits, CTC checks your manually provisioned path
against the path diversity option you choose. If the path does not meet the path
diversity requirement that is specified, an error message appears.
14. If you selected Fully Protected Path in Step 12 and the circuit will be routed on an SNCP DRI, click
the Dual Ring Interconnect check box.
15. Click Next. In the Route Review and Edit area, node icons appear so you can route the circuit
manually. The green arrows pointing from the selected node to other network nodes indicate spans
that are available for routing the circuit.
16. Complete the "DLP-D98 Provision a High-Order Circuit Route" task.
17. Click Finish. After completing the circuit, the Circuits window appears.
18. In the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit,
and Search buttons become active.
19. Click Edit. The Edit Circuit window appears with the General tab selected. Nodes in the DCC
network are shown graphically. Circuit source and destination information appears under the source
and destination nodes. To see a detailed view of the circuit, click Show Detailed Map. You can
rearrange the node icons by pressing Ctrl while you drag and drop the icon to the new location.
20. In the Edit Circuit dialog box, click the Drops tab. A list of existing drops appears.
21. Click Create.
22. In the Define New Drop dialog box, define the new drop:
1. Node-Choose the target node for the circuit drop.
2. Slot-Choose the target card and slot.
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3. Port, VC4-Choose the port and/or VC4 from the Port and VC4 drop-down lists. The choice
in these drop-down lists depends on the card selected in SubStep 2. See Table 6-2 for a list of
options.
4. The routing preferences for the new drop match those of the original circuit. However, you
can modify the following:
• If the original circuit was routed on a protected SNCP path, you can change
the nodal diversity options: Nodal Diversity Required, Nodal Diversity
Desired, or Link Diversity Only. See Step 13 for descriptions.
• If the original circuit was not routed on a protected path, the Protection
Channel Access option is available. See Step 12 for a description of the
Protection Channel Access option.
5. Click OK. The new drop appears in the Drops list.
23. If you need to create additional drops on the circuit, repeat Steps 21 and 22.
24. Click Close. The Circuits window appears.
25. Verify that the new drops appear in the Destination column for the circuit that you edited. If they do
not appear, repeat Steps 21 through 24, making sure that all options are provisioned correctly.
26. Complete the NTP-D62 Test High-Order Circuits.
Stop. You have completed this procedure.

NTP-D62 Test High-Order Circuits
Purpose
Tools/Equipment

This procedure tests a high-order circuit.
Test set capable of optical speeds, appropriate fibers, and attenuators
This procedure assumes that you completed facility loopback tests to test the fibers and
cables from the source and destination ONS 15454 SDHs to the fiber distribution panel
or the DSX and one of following circuit procedures:
NTP-D323 Create an Automatically Routed High-Order Circuit

Prerequisite
Procedures

NTP-D324 Create a Manually Routed High-Order Circuit
NTP-D190 Create a Unidirectional High-Order Circuit with Multiple Drops
NTP-D284 Create a Manually Routed VCAT Circuit
NTP-D325 Create an STM Test Circuit around the Ring

Required/As
Needed
Onsite/Remote
Security Level

Required
Onsite
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
test the high-order circuits. If you are already logged in, continue with Step 2.
2. From the View menu, choose Go to Network View.
3. Click the Circuits tab.
4. Complete the "DLP-D230 Change a Circuit State" task and set the circuit and circuit ports to the
Locked-enabled,maintenance service state.
5. Set up the patch cable at the destination node:
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1. Test the patch cable by connecting one end to the test set Tx port and the other end to the test
Rx port. If the test set does not run error-free, check the cable for damage and check the test
set to make sure it is set up correctly.
2. Install the loopback cable on the port you are testing between the Tx and Rx connections.
6. Set up the loopback cable at the source node:
1. Test the loopback cable by connecting one end to the test set Tx port and the other end to the
test Rx port. If the test set does not run error-free, check the cable for damage and check the
test set to make sure it is set up correctly.
2. At the source node, attach the loopback cable to the port you are testing. Connect the test set
to the circuit source port: Tx port of the test set to the circuit Rx port, and the test set Rx port
to the circuit Tx port.
7. Configure the test set for the source ONS 15454 SDH card:
♦ STM-1 cards-You will test a VC4 circuit on one of the STM-1 ports. Configure the test set
for an STM-1 port.
♦ STM-4 cards-You will test either a VC4-4c or a multiplexed VC4-4. If you are testing a
VC4-4c, configure the test set for a VC4-4c. If you are testing a multiplexed VC4-4,
configure the test set for a multiplexed VC4-4 and choose the E3, DS3i-N-12, or E1 you will
test. For information about configuring your test set, consult your test set user guide.
♦ STM-16 cards-You will test either a VC4-16c or a multiplexed VC4-16. If you are testing a
VC4-16c, configure the test set for a VC4-16c. If you are testing a multiplexed VC4-16,
configure the test set for a multiplexed VC4-16 and choose the E3, DS3i-N-12, or E1 you
will test. For information about configuring your test set, consult your test set user guide.
♦ STM-64 cards-You will test a VC4-64c or a multiplexed VC4-64. If you are testing a
VC4-64c, configure the test set for a VC4-64c. If you are testing a multiplexed VC4-64,
configure the test set for a multiplexed VC4-64 and choose the E3, DS3i-N-12, or E1 you
will test. For information about configuring your test set, consult your test set user guide.
8. Verify that the test set shows a clean signal. If a clean signal does not appear, repeat Steps 1 through
7 to make sure you have configured the test set and cabling correctly.
9. Inject errors from the test set. Verify that the errors appear at the source and destination nodes.
10. Clear the PM counts for the ports that you tested. See the "DLP-D459 Clear Selected PM Counts"
task for instructions.
11. Perform protection switch testing appropriate to the SDH topology:
♦ For SNCP rings, see the "DLP-D94 SNCP Protection Switching Test" task.
♦ For MS-SPRings see the "DLP-D91 MS-SPRing Switch Test" task.
12. Perform a BERT for 12 hours or follow your site requirements for length of time. For information
about configuring your test set for BERT, see your test set user guide.
13. After the BERT is complete, print the results or save them to a disk for future reference. For
information about printing or saving test results, see your test set user guide.
14. Complete the "DLP-D230 Change a Circuit State" task and change the circuit and circuit ports from
Unlocked,maintenance to their previous service states.
Stop. You have completed this procedure.

NTP-D139 Create a Half Circuit on an MS-SPRing or 1+1 Node
Purpose
Tools/Equipment
Prerequisite
Procedures

This procedure creates a low-order or high-order circuit from a drop card to an
STM-N trunk (span) card on the same node in an MS-SPRing or 1+1 topology.
None
NTP-D127 Verify Network Turn-Up
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Required/As Needed As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
1. Complete the "DLP-D60 Log into CTC" task at the ONS 15454 SDH where you will create the half
circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. From the View menu, choose Go to Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-For low-order circuits, choose VC_LO_PATH_CIRCUIT. For high-order
circuits, choose VC_HO_PATH_CIRCUIT. VC4 cross-connects carry the circuit across
the ONS 15454 SDH network.
♦ Number of Circuits-Enter the number of circuits that you want to create. The default is 1.
♦ Auto-ranged-This check box is automatically selected if you enter more than 1 in the
Number of Circuits field. Uncheck the box.
6. Click Next.
7. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-For high-order circuits, choose VC4. For low-order circuits, choose VC11, VC12, or
VC3.
♦ Bidirectional-Leave checked for this circuit (default).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Select this check box if you want to apply the state chosen in the State
field to the circuit source and destination ports. CTC applies the circuit state to the ports only
if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger
than the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning
dialog box shows the ports where the circuit state could not be applied. If the box is
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unchecked, CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Uncheck this check box if it is selected.
8. Click Next.
9. Complete the "DLP-D311 Provision a Half Circuit Source and Destination on an MS-SPRing or 1+1
Node" task.
10. Click Finish. One of the following results occurs, depending on the circuit properties you chose in
the Circuit Creation dialog box:
⋅ If you entered more than 1 in Number of Circuits and selected Auto-ranged, CTC
automatically creates the number of circuits entered in Number of Circuits. If
auto-ranging cannot complete all the circuits, for example, because sequential ports
are unavailable at the source or destination, a dialog box appears. Set the new source
or destination for the remaining circuits, then click Finish to continue auto-ranging.
After completing the circuits, the Circuits window appears.
⋅ If you entered more than 1 in the Number of Circuits field and did not choose
Auto-ranged, the Circuit Creation dialog box appears so you can create the
remaining circuits. Repeat Steps 4 through 9 for each additional circuit. After
completing the circuits, the Circuits window appears.
11. In the Circuits window, verify that the new circuits appear in the circuits list.
Stop. You have completed this procedure.

NTP-D140 Create a Half Circuit on an SNCP Ring Node
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates a low-order or high-order circuit from a drop card to an
STM-N trunk (span) card on the same SNCP ring node.
None
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at the ONS 15454 SDH where you will create the half
circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. From the View menu, choose Go to Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-For low-order circuits, choose VC_LO_PATH_CIRCUIT. For high-order
circuits, choose VC_HO_PATH_CIRCUIT. VC4 cross-connects carry the circuit across
the ONS 15454 SDH network.
♦ Number of Circuits-Enter the number of circuits that you want to create. The default is 1.
♦ Auto-ranged-This check box is automatically selected if you enter more than 1 in the
Number of Circuits field. Uncheck the box.
NTP-D140 Create a Half Circuit on an SNCP Ring Node
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6. Click Next.
7. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-For high-order circuits, choose VC4. For low-order circuits, choose VC11, VC12, or
VC3.
♦ Bidirectional-Leave checked for this circuit (default).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this box if you want to apply the state chosen in the State field to
the circuit source and destination ports. CTC applies the circuit state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog
box shows the ports where the circuit state could not be applied. If the box is unchecked,
CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Protected Drops-Uncheck this check box if it is selected.
8. Complete the "DLP-D218 Provision SNCP Ring Selectors During Circuit Creation" task.
9. Click Next.
10. Complete the "DLP-D312 Provision a Half Circuit Source and Destination on an SNCP Ring" task.
11. Click Finish. One of the following results occurs, depending on the circuit properties you chose in
the Circuit Creation dialog box. If you entered more than 1 in the Number of Circuits field, the
Circuit Creation dialog box appears so you can create the remaining circuits. Repeat Steps 5 through
9 for each additional circuit. After completing the circuits, the Circuits window appears.
12. In the Circuits window, verify that the new circuits appear in the circuits list.
13. Complete the NTP-D135 Test Low-Order Circuits. Skip this step if you built a test circuit.
Stop. You have completed this procedure.
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NTP-D191 Create an E-Series EtherSwitch Circuit (Multicard or
Single-Card Mode)
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

This procedure creates a multicard or single-card EtherSwitch circuit. It does not apply
to E-Series cards in port-mapped mode. To create a port-mapped mode circuit, see the
NTP-D192 Create a Circuit for an E-Series Card in Port-Mapped Mode.
E-Series Ethernet cards (E100T-G or E1000-2-G) must be installed at each end of the
Ethernet circuit.
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. If a high number of VLANs is already used by the network, complete the "DLP-D99 Determine
Available VLANs" task to verify that sufficient VLAN capacity is available. (You will create a
VLAN during each circuit creation task.)
4. If enough VLANs are not available, complete the "DLP-D34 Delete VLANs" task to free space.
5. Verify that the circuit source and destination Ethernet cards are provisioned for the mode of the
circuit you will create, either multicard or single-card. See the "DLP-D246 Provision E-Series
Ethernet Card Mode" task.
6. From the View menu, choose Go to Network View.
7. Click the Circuits tab, then click Create.
8. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default unchanged (1).
♦ Auto-ranged-Unavailable.
9. Click Next.
10. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose the circuit size. Valid circuit sizes for an Ethernet multicard circuit are VC4 and
VC4-2c. Valid circuit sizes for an Ethernet single-card circuit are VC4, VC4-2c, and
VC4-4c.
♦ Bidirectional-Leave the default unchanged (checked).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose IS. Ethergroup circuits are always in service.
♦ Apply to drop ports-Uncheck this box.
♦ Protected Drops-Leave the default unchanged (unchecked).
11. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
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Caution! Layer 1 SDH protection does not extend to multicard EtherSwitch circuits on SNCP rings.
Caution! A TCC2/TCC2P card reset disrupts single-card and multicard Etherswitch circuits for 45 seconds
to two minutes. During this time, a spanning tree topology is created by the newly activated TCC2/TCC2P
card.
12. Click Next.
13. Provision the circuit source:
1. From the Node drop-down list, choose one of the EtherSwitch circuit endpoint nodes. (Either
end node can be the EtherSwitch circuit source.)
2. From the Slot drop-down list, choose one of the following:
• If you are building a multicard EtherSwitch circuit, choose Ethergroup.
• If you are building a single-card EtherSwitch circuit, choose the Ethernet
card where you enabled the single-card EtherSwitch.
14. Click Next.
15. Provision the circuit destination:
1. From the Node drop-down list, choose the second EtherSwitch circuit endpoint node.
2. From the Slot drop-down list, choose one of the following:
• If you are building a multicard EtherSwitch circuit, choose Ethergroup.
• If you are building a single-card EtherSwitch circuit, choose the Ethernet
card where you enabled the single-card EtherSwitch.
16. Click Next.
17. In the Circuit VLAN Selection area, click New VLAN. If the VLAN already exists, continue with
Step 20.
Tip: You can also add VLANs in network view by choosing Tools > Manage
VLANs. In the All VLANs dialog box, click the Create button to open the Define
New VLAN dialog box.
18. In the New VLAN dialog box, complete the following:
⋅ VLAN Name-Assign an easily identifiable name to your VLAN.
⋅ VLAN ID-Assign a VLAN ID. The VLAN ID should be the next available number
between 2 and 4093 that is not already assigned to an existing VLAN. Each ONS
15454 SDH network supports a maximum of 509 user-provisionable VLANs.
⋅ Topology Host-Choose the topology host ID from the drop-down list.
19. Click OK.
20. In the Circuit VLAN Selection area, highlight the VLAN name and click the arrow button to move
the available VLANs to the Circuit VLANs column.
21. If you are building a single-card EtherSwitch circuit and want to disable spanning tree protection on
this circuit, uncheck the Enable Spanning Tree check box and click OK on the Disabling Spanning
Tree dialog box. The Enable Spanning Tree box remains checked or unchecked for the creation of
the next single-card, point-to-point Ethernet circuit.
Caution! Disabling spanning tree protection increases the likelihood of logic loops on an Ethernet
network.
Caution! Turning off spanning tree on a circuit-by-circuit basis means that the ONS 15454 SDH is
no longer protecting the Ethernet circuit and that the circuit must be protected by another mechanism
in the Ethernet network.
Caution! Multiple circuits with spanning tree protection enabled incur blocking if the circuits
traverse the same E-Series card and use the same VLAN.
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Spanning tree rules prevent users from creating new circuits or modifying existing circuits if the
circuits do not meet certain VLAN assignment constraints. If the VLAN set of the new circuit
overlaps with existing circuits, the same spanning tree instance is used for all circuits. If the VLAN
set of the new circuit overlaps with VLAN sets of existing circuits with different spanning tree
instances, the VLAN assignment fails. Cisco recommends that you plan VLAN assignments so that
circuits with larger VLAN sets and a higher chance of overlap are added first. This means that if a
circuit with an overlapping VLAN set is added, it collapses into the same spanning tree. To view
circuits mapped to a spanning tree and their VLAN assignments, see the "DLP-D23 View Spanning
Tree Information" task.
You can disable or enable spanning tree protection on a circuit-by-circuit basis only for single-card,
point-to-point Ethernet circuits. Other E-Series Ethernet configurations disable or enable spanning
tree on a port-by-port basis.
22. Click Next.
23. Confirm that the following information about the circuit is correct:
⋅ Circuit name
⋅ Circuit type
⋅ Circuit size
⋅ ONS 15454 SDH circuit nodes
24. Click Finish.
25. Complete the "DLP-D220 Provision E-Series Ethernet Ports" task.
26. Complete the "DLP-D221 Provision E-Series Ethernet Ports for VLAN Membership" task.
27. Complete the NTP-D146 Test E-Series Circuits.
Stop. You have completed this procedure.

NTP-D192 Create a Circuit for an E-Series Card in Port-Mapped
Mode
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates an E-Series point-to-point SDH circuit with an E-Series card
in port-mapped mode.
An E-Series Ethernet card must be installed at each end of the circuit and
configured in port-mapped mode.
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. Complete the "DLP-D246 Provision E-Series Ethernet Card Mode" task.
4. Provision and enable the Ethernet ports. See "DLP-D220 Provision E-Series Ethernet Ports" task.
5. From the View menu, choose Go to Network View.
6. Click the Circuits tab and click Create.
7. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
NTP-D192 Create a Circuit for an E-Series Card in Port-Mapped Mode
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♦ Number of Circuits-Leave the default (1) unchanged.
8. Click Next.
9. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose the circuit size. Valid circuit sizes for an E-Series in port-mapped mode are
VC4, VC4-2c, and VC4-4c.
♦ Bidirectional-Leave the default (checked) unchanged.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Select this check box if you want to apply the state chosen in the State
field (Unlocked or Locked,maintenance only) to the Ethernet circuit source and destination
ports. You cannot apply Unlocked,automaticInService to E-Series Ethernet card ports. CTC
applies the circuit state to the ports only if the circuit bandwidth is the same as the port
bandwidth or, if the port bandwidth is larger than the circuit, the circuit must be the first
circuit to use the drop port. If not, a Warning dialog box shows the ports where the circuit
state could not be applied. If the box is unchecked, CTC does not change the state of the
source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
◊ Auto-ranged-Unavailable.
◊ Protected Drops-Leave the default unchanged (unchecked).
10. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
11. Click Next.
12. Provision the circuit source:
1. From the Node drop-down list, choose the circuit source node. Either end node can be the
point-to-point circuit source.
2. From the Slot drop-down list, choose the slot containing the E-Series card that you will use
for one end of the point-to-point circuit.
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3. From the Port drop-down list, choose a port.
13. Click Next.
14. Provision the circuit destination:
1. From the Node drop-down list, choose the circuit destination node.
2. From the Slot drop-down list, choose the slot containing the E-Series card that you will use
for other end of the point-to-point circuit.
3. From the Port drop-down list, choose a port.
15. Click Next. The Circuits window appears.
16. Confirm that the following circuit information is correct:
⋅ Circuit name
⋅ Circuit type
⋅ Circuit size
⋅ ONS 15454 SDH circuit nodes
17. Click Finish.
18. Complete the NTP-D146 Test E-Series Circuits.
Stop. You have completed this procedure.

NTP-D142 Create an E-Series Shared Packet Ring Ethernet Circuit
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates a shared packet ring Ethernet circuit. It does not apply to
E-Series cards in port-mapped mode.
E-Series Ethernet cards must be installed at both Ethernet circuit endpoint nodes.
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. If a high number of VLANs is already used by the system, complete the "DLP-D99 Determine
Available VLANs" task to verify that sufficient VLAN capacity is available. (You will create a
VLAN during each circuit creation task.)
4. Verify that the Ethernet cards that will carry the circuit are provisioned for Multicard EtherSwitch
Group. See the "DLP-D246 Provision E-Series Ethernet Card Mode" task.
5. Provision and enable the Ethernet ports. See "DLP-D220 Provision E-Series Ethernet Ports" task.
6. From the View menu, choose Go to Network View.
7. Click the Circuits tab and click Create.
8. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default (1) unchanged.
♦ Auto-ranged-Unavailable.
9. Click Next.
10. Provision the circuit destination:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
NTP-D142 Create an E-Series Shared Packet Ring Ethernet Circuit

67

ONS_15454_SDH_Procedure_Guide_R8.5.1_--_Create_Circuits_and_Low-Order_Tunnels
create monitor circuits.
♦ Size-Choose the circuit size. Valid shared packet ring circuit sizes are VC4 and VC4-2c.
♦ Bidirectional-Leave the default unchanged (checked).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose IS (in service). Ethergroup circuits are always in service.
♦ Apply to drop ports-Uncheck this box; states cannot be applied to E-Series ports.
♦ Protected Drops-Leave the default unchanged (unchecked).
11. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
Caution! Layer 1 SDH protection does not extend to multicard EtherSwitch circuits on SNCP rings.
12. Click Next.
13. Provision the circuit source:
1. From the Node drop-down list, choose one of the shared packet ring circuit endpoint nodes.
(Either end node can be the shared packet ring circuit source.)
2. From the Slot drop-down list, choose Ethergroup.
14. Click Next.
15. Provision the circuit destination:
1. From the Node drop-down list, choose the second shared packet ring circuit endpoint node.
2. From the Slot drop-down list, choose Ethergroup.
16. Click Next.
17. Review the VLANs in the Available VLANs list. If the VLAN you want to use appears, continue
with Step 18. If you need to create a new VLAN, complete the following steps:
1. Click the New VLAN button.
2. In the New VLAN dialog box, complete the following:
• VLAN Name-Assign an easily identifiable name to your VLAN.
• VLAN ID-Assign a VLAN ID. The VLAN ID should be the next available
number between 2 and 4093 that is not already assigned to an existing
VLAN. Each ONS 15454 SDH network supports a maximum of 509
user-provisionable VLANs.
• Topology Host-Choose the topology host ID from the drop-down list.
3. Click OK.
Tip: You can also add VLANs in network view by choosing Tools > Manage
VLANs. In the All VLANs dialog box, click the Create button to open the Define
New VLAN dialog box.
18. In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to
move the VLAN to the Circuit VLANs column.
Note: Moving the VLAN from Available VLANs to Circuit VLANs forces all the
VLAN traffic to use the shared packet ring you are creating.
19. Click Next.
20. In the Circuit Routing Preferences area, uncheck the Route Automatically check box and click
Next.
21. In the Route Review and Edit area, click the source node, then click a span (green arrow) leading
away from the source node.
The span turns white.
22. Click Add Span.
The span turns blue. CTC adds the span to the Included Spans list.
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23. Click the node at the end of the blue span.
24. Click the green span attached to the node you clicked in Step 23.
The span turns white.
25. Click Add Span.
The span turns blue.
26. Repeat Steps 23 through 25 for every node in the ring.
27. Verify that the new circuit is correctly configured in the Route Review and Edit area. If the circuit
information is not correct, click the Back button and repeat the procedure with the correct
information.
Note: If the circuit is incorrect, you can also click Finish, delete the completed circuit, and
begin the procedure again.
28. Click Finish.
29. Complete the "DLP-D220 Provision E-Series Ethernet Ports" task for each node that carries the
circuit.
30. Complete the "DLP-D221 Provision E-Series Ethernet Ports for VLAN Membership" task for each
node that carries the circuit.
31. Complete the NTP-D146 Test E-Series Circuits.
Stop. You have completed this procedure.

NTP-D143 Create an E-Series Hub-and-Spoke Ethernet Configuration
Purpose
Tools/Equipment

This procedure creates a hub-and-spoke Ethernet configuration, which is made up of
multiple circuits that share a common endpoint. It does not apply to E-Series cards in
port-mapped mode.
E-Series Ethernet cards (E100T-G or E1000-2-G) must be installed at all Ethernet
circuit endpoint nodes.

Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
1. Complete the "DLP-D60 Log into CTC" task at the hub node (the common endpoint). If you are
already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. Complete the DLP-D99 Determine Available VLANs|"DLP-D99 Determine Available VLANs" task
to verify that sufficient VLAN capacity is available. (You will create a VLAN during each circuit
creation task.)
4. Verify that the Ethernet card that will carry the hub-and-spoke circuit is provisioned for Single-card
EtherSwitch Group. See the "DLP-D246 Provision E-Series Ethernet Card Mode" task.
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5. Provision and enable the Ethernet ports. See "DLP-D220 Provision E-Series Ethernet Ports" task.
6. Log into the spoke node and repeat Steps 4 and 5 for the Ethernet card in the other circuit endpoint.
(You only need to verify that the hub node is provisioned for single-card EtherSwitch once.)
7. Click the Circuits tab and click Create.
8. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default (1) unchanged.
♦ Auto-ranged-Unavailable.
9. Click Next.
1. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose the circuit size. Valid circuit sizes for a single-card EtherSwitch circuit are
VC4, VC4-2c, and VC4-4c.
♦ Bidirectional-Leave the default unchanged (checked).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Leave the default (IS) unchanged. Ethergroup circuits are always in service.
♦ Apply to drop ports-Uncheck this box; states cannot be applied to E-Series ports.
♦ Protected Drops-Leave the default unchanged (unchecked).
2. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
3. Click Next.
4. Provision the circuit source:
1. From the Node drop-down list, choose the hub node.
2. From the Slot drop-down list, choose the Ethernet card where you enabled the single-card
EtherSwitch.
5. Click Next.
6. Provision the circuit destination:
1. From the Node drop-down list, choose an EtherSwitch circuit endpoint node.
2. From the Slot drop-down list, choose the Ethernet card where you enabled the single-card
EtherSwitch.
7. Click Next.
8. Review the VLANs in the Available VLANs list. If the VLAN you want to use appears, continue
with Step 19. If you need to create a new VLAN, complete the following steps:
1. Click the New VLAN button.
2. In the New VLAN dialog box, complete the following:
◊ VLAN Name-Assign an easily identifiable name to your VLAN.
◊ VLAN ID-Assign a VLAN ID. The VLAN ID should be the next available number
between 2 and 4093 that is not already assigned to an existing VLAN. Each ONS
15454 SDH network supports a maximum of 509 user-provisionable VLANs.
◊ Topology Host-Choose the topology host ID from the drop-down list.
3. Click OK.
Tip: You can also add VLANs in network view by choosing Tools > Manage VLANs. In
the All VLANs dialog box, click the Create button to open the Define New VLAN dialog
box.
9. In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to
move the VLAN to the Circuit VLANs column.

NTP-D143 Create an E-Series Hub-and-Spoke Ethernet Configuration

70

ONS_15454_SDH_Procedure_Guide_R8.5.1_--_Create_Circuits_and_Low-Order_Tunnels
Note: Moving the VLAN from Available VLANs to Circuit VLANs forces all the VLAN
traffic to use the shared packet ring you are creating.
10. Click Next.
11. Confirm that the following information about the hub-and-spoke circuit is correct:
♦ Circuit name
♦ Circuit type
♦ Circuit size
♦ VLAN names
♦ ONS 15454 SDH circuit nodes
If the circuit information is not correct, click the Back button and repeat the procedure with
the correct information. If the information is correct, check Route Automatically.
Note: You can also click Finish, delete the completed circuit, and start the procedure from
the beginning.
12. Click Finish.
13. Complete the "DLP-D220 Provision E-Series Ethernet Ports" task.
14. Complete the "DLP-D221 Provision E-Series Ethernet Ports for VLAN Membership" task.
15. Complete the NTP-D146 Test E-Series Circuits.
16. To create additional circuits (spokes), repeat Steps 3 through 24.
Stop. You have completed this procedure.

NTP-D144 Create an E-Series Single-Card EtherSwitch Manual
Cross-Connect
This procedure manually creates a single-card EtherSwitch cross-connect
between E-Series Ethernet cards and STM-N cards connected to non-ONS
equipment.
E-Series Ethernet cards (E100T-G or E1000-2-G) must be installed at the
Tools/Equipment
circuit source node.
Prerequisite Procedures
NTP-D127 Verify Network Turn-Up
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: In this procedure, cross-connect refers to a circuit connection created within the same node between
the Ethernet card and an STM-N card that is connected to third-party equipment. You create cross-connects
at the source and destination nodes so that an Ethernet circuit can be routed from source to destination across
third-party equipment.
Purpose

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. If a high number of VLANs is already used by the network, complete the "DLP-D99 Determine
Available VLANs" task to verify that sufficient VLAN capacity is available. (You will create a
VLAN during each circuit creation task.)
4. In the node view, double-click the Ethernet card that will carry the cross-connect.
5. Verify that the Ethernet card that will carry the circuit is provisioned for single-card EtherSwitch.
See the "DLP-D246 Provision E-Series Ethernet Card Mode" task.
6. From the View menu, choose Go to Network View.
7. Click the Circuits tab and click Create.
8. In the Circuit Creation dialog box, complete the following fields:
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♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default unchanged (1).
♦ Auto-ranged-Unavailable.
9. Click Next.
10. Define the circuit attributes:
♦ Name-Assign a name to the cross-connect. The name can be alphanumeric and up to 48
characters (including spaces). Circuit names should be 44 characters or less if you want the
ability to create monitor circuits. If you leave the field blank, CTC assigns a default name to
the cross-connect.
♦ Size-Choose the cross-connect size. For single-card EtherSwitch, the available sizes are
VC4, VC4-2c, and VC4-4c.
♦ Bidirectional-Leave the default (checked) unchanged.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Uncheck this box.
♦ Protected Drops-Leave the default unchanged (unchecked).
11. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
12. Click Next.
13. Provision the circuit source:
1. From the Node drop-down list, choose the cross-connect source node.
2. From the Slot drop-down list, choose the Ethernet card where you verified the single-card
EtherSwitch in Step 5.
14. Click Next.
15. Provision the circuit destination:
1. From the Node drop-down list, choose the cross-connect circuit source node selected in Step
13. (For Ethernet cross-connects, the source and destination nodes are the same.)
2. From the Slot drop-down list, choose the STM-N card that is connected to the non-ONS
equipment.
3. Depending on the STM-N card, choose the port and/or circuit size from the Port and Size
drop-down lists.
16. Click Next.
17. Review the VLANs in the Available VLANs list. If the VLAN you want to use appears, continue
with Step 18. If you need to create a new VLAN, complete the following steps:
1. Click the New VLAN button.
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2. In the New VLAN dialog box, complete the following:
◊ VLAN Name-Assign an easily identifiable name to your VLAN.
◊ VLAN ID-Assign a VLAN ID. The VLAN ID should be the next available number
between 2 and 4093 that is not already assigned to an existing VLAN. Each ONS
15454 SDH network supports a maximum of 509 user-provisionable VLANs.
◊ Topology Host-Choose the topology host ID from the drop-down list.
3. Click OK.
Tip: You can also add VLANs in network view by choosing Tools > Manage VLANs. In
the All VLANs dialog box, click the Create button to open the Define New VLAN dialog
box.
18. Click the VLAN you want to use on the Available VLANs column, then click the arrow (>>) button
to move the VLAN to the Circuit VLANs column.
19. Click Next. The Circuit Creation (Circuit Routing Preferences) dialog box appears.
20. Confirm that the following information about the single-card EtherSwitch manual cross-connect is
correct (in this task, "circuit" refers to the Ethernet cross-connect):
♦ Circuit name
♦ Circuit type
♦ Circuit size
♦ VLAN names
♦ ONS 15454 SDH nodes
If the information is not correct, click the Back button and repeat the procedure with the
correct information.
21. Click Finish.
22. Complete the "DLP-D220 Provision E-Series Ethernet Ports" task.
23. Complete the "DLP-D221 Provision E-Series Ethernet Ports for VLAN Membership" task.
24. Complete the NTP-D146 Test E-Series Circuits.
Stop. You have completed this procedure.

NTP-D145 Create an E-Series Multicard EtherSwitch Manual
Cross-Connect
This procedure manually creates multicard EtherSwitch cross-connects
Purpose
between E-Series Ethernet cards and STM-N cards connected to non-ONS
equipment.
Tools/Equipment
E-Series Ethernet cards must be installed at the circuit source node.
Prerequisite Procedures
NTP-D127 Verify Network Turn-Up
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
Note: In this procedure, cross-connect refers to a circuit connection created within the same node between
the Ethernet card and an STM-N card connected to third-party equipment. You create cross-connects at the
source and destination nodes so an Ethernet circuit can be routed from source to destination across
third-party equipment.
1. Complete the "DLP-D60 Log into CTC" task at a circuit endpoint. If you are already logged in,
continue with Step 2.
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2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. Complete the "DLP-D99 Determine Available VLANs" task to verify that sufficient VLAN capacity
is available. (You will create a VLAN during each circuit creation task.)
4. Verify that the Ethernet card that will carry the circuit is provisioned for Multicard EtherSwitch
Group. See the DLP-D246 Provision E-Series Ethernet Card Mode" task.
5. Provision and enable the Ethernet ports. See "DLP-D220 Provision E-Series Ethernet Ports" task.
6. From the View menu, choose Go to Network View.
7. Click the Circuits tab and click Create.
8. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default unchanged (1).
♦ Auto-ranged-Unavailable.
9. Click Next.
10. Define the circuit attributes:
♦ Name-Assign a name to the source cross-connect. The name can be alphanumeric and up to
48 characters (including spaces). Circuit names should be 44 characters or less if you want
the ability to create monitor circuits. If you leave the field blank, CTC assigns a default name
to the source cross-connect.
♦ Size-Choose the size of the circuit that will be carried by the cross-connect. For multicard
EtherSwitch circuits, the available sizes are VC4 and VC4-2c.
♦ Bidirectional-Leave the default unchanged (checked).
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Uncheck this box.
♦ Protected Drops-Leave the default (unchecked) unchanged.
11. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
12. Click Next.
13. Provision the cross-connect source:
1. From the Node drop-down list, choose the cross-connect source node.
2. From the Slot drop-down list, choose Ethergroup.
14. Click Next.
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15. From the Node drop-down list under Destination, choose the circuit source node selected in Step 13.
(For Ethernet cross-connects, the source and destination nodes are the same.)
The Slot field is provisioned automatically for Ethergroup.
16. Click Next.
17. Review the VLANs in the Available VLANs list. If the VLAN you want to use appears, continue
with Step 18. If you need to create a new VLAN, complete the following steps:
1. Click the New VLAN button.
2. In the New VLAN dialog box, complete the following:
◊ VLAN Name-Assign an easily identifiable name to your VLAN.
◊ VLAN ID-Assign a VLAN ID. The VLAN ID should be the next available number
between 2 and 4093 that is not already assigned to an existing VLAN. Each ONS
15454 SDH network supports a maximum of 509 user-provisionable VLANs.
◊ Topology Host-Choose the topology host ID from the drop-down list.
3. Click OK.
Tip: You can also add VLANs in network view by choosing Tools > Manage VLANs. In
the All VLANs dialog box, click the Create button to open the Define New VLAN dialog
box.
18. In the Available VLANs column, click the VLAN you want to use and click the arrow button to
move the VLAN to the Circuit VLANs column.
19. Click Next.
The Circuit Creation (Circuit Routing Preferences) dialog box appears.
20. Verify the cross-connect information (in this step, "circuit" refers to the Ethernet cross-connect):
♦ Circuit name
♦ Circuit type
♦ Circuit size
♦ VLANs
♦ ONS 15454 SDH nodes
If the information is not correct, click the Back button and repeat the procedure with the
correct information. If the information is correct, check Route Automatically.
21. Click Finish.
22. Complete the "DLP-D220 Provision E-Series Ethernet Ports" task.
23. Complete the "DLP-D221 Provision E-Series Ethernet Ports for VLAN Membership" task.
24. From the View menu, choose Go to Home View.
25. Click the Circuits tab.
26. Highlight the circuit and click Edit.
The Edit Circuit dialog box appears.
27. Click Drops and click Create.
The Define New Drop dialog box appears.
28. From the Slot drop-down list, choose the STM-N card that links the ONS 15454 SDH to the
non-ONS 15454 SDH equipment.
29. From the Port drop-down list, choose the appropriate port.
30. From theVC4 drop-down list, choose the VC4 that matches the VC4 of the connecting non-ONS
15454 SDH equipment.
31. Click OK.
32. Confirm the circuit information appears in the Edit Circuit dialog box and click Close.
33. Repeat Steps 3 through 32 at the second Ethernet manual cross-connect endpoint. The Ethernet
circuits that are created first and second will be bridged by the appropriate circuit in the non-ONS
equipment.
Note: The appropriate circuit must exist in the non-ONS equipment to connect the two
Ethernet manual cross-connect endpoints.
Caution! If a CARLOSS alarm repeatedly appears and clears on an Ethernet manual cross-connect, the two
Ethernet circuits might have a circuit-size mismatch, for example, if a circuit size of VC4 was configured on
NTP-D145 Create an E-Series Multicard EtherSwitch Manual Cross-Connect
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the first ONS 15454 SDH and a circuit size of VC4-2c was configured on the second ONS 15454 SDH.
Refer to the Cisco ONS 15454 SDH Troubleshooting Guide if the alarm persists.
34. Complete the NTP-D146 Test E-Series Circuits.
Stop. You have completed this procedure.

NTP-D146 Test E-Series Circuits
Purpose
Tools/Equipment

This procedure tests circuits created on E-Series Ethernet cards that are
provisioned for multicard EtherSwitch, single-card EtherSwitch, or
port-mapped mode.
Ethernet test set and appropriate fibers
This procedure assumes that you completed facility loopback tests to test the
fibers and cables from the source and destination ONS 15454 SDHs to the
fiber distribution panel or the DSX, and one of the following procedures:
NTP-D191 Create an E-Series EtherSwitch Circuit (Multicard or Single-Card
Mode)
NTP-D192 Create a Circuit for an E-Series Card in Port-Mapped Mode

Prerequisite Procedures
NTP-D142 Create an E-Series Shared Packet Ring Ethernet Circuit
NTP-D143 Create an E-Series Hub-and-Spoke Ethernet Configuration
NTP-D144 Create an E-Series Single-Card EtherSwitch Manual
Cross-Connect

Required/As Needed
Onsite/Remote
Security

NTP-D145 Create an E-Series Multicard EtherSwitch Manual Cross-Connect
As needed
Onsite
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at the ONS 15454 SDH source Ethernet node. If you
are already logged in, continue with Step 2.
2. On the shelf graphic, double-click the circuit source card.
3. Click the Provisioning > Port tabs.
4. Verify the following settings:
♦ Mode-Set to Auto, 10 Half, 10 Full, 100 Half, or 100 Full.
♦ Enabled-Checked.
♦ Priority-Set to the priority level indicated by the circuit or site plan. Priority does not apply
to E-Series cards in port-mapped mode.
♦ Stp State-Checked if Spanning Tree Protocol (STP) is enabled for the circuit. STP does not
apply to E-Series cards in port-mapped mode.
5. Click the VLAN tab. If the E-Series cards is not in port-mapped mode, verify that the source port is
on the same VLAN as the destination port.
6. Repeat Steps 2 through 5 for the destination card.
7. At the destination node, connect an Ethernet test set to the destination port and configure the test set
to send and receive the appropriate Ethernet traffic.
Note: At this point, you are not able to send and receive Ethernet traffic.
NTP-D146 Test E-Series Circuits
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8. At the source node, connect an Ethernet test set to the source port and configure the test set to send
and receive the appropriate Ethernet traffic.
9. Transmit Ethernet frames between both test sets. If you cannot transmit and receive Ethernet traffic
between the nodes, repeat Steps 2 through 8 to make sure that you configured the Ethernet ports and
test set correctly.
10. Perform protection switch testing appropriate to the topology:
♦ For SNCP rings, see the "DLP-D94 SNCP Protection Switching Test" task.
♦ For MS-SPRings see the "DLP-D91 MS-SPRing Switch Test" task.
Configure your test set according to local site practice. For information about configuring
your test set, see your test set user guide.
11. After the Ethernet test is complete, print the results or save them to a disk for future reference. For
information about printing or saving test results, see your test set user guide.
Stop. You have completed this procedure.

NTP-D148 Create a Manual Cross-Connect for a G-Series or E-Series
Card in Port-Mapped Mode
Purpose

This procedure manually creates a cross-connect between a G-Series Ethernet card or
an E-Series Ethernet card in Port-mapped mode and an STM-N card connected to
non-ONS equipment.
A G-Series or E-Series card must be installed at the circuit source node.

Tools/Equipment
Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
Note: In this procedure, cross-connect refers to a circuit connection created within the same node between
the Ethernet card and an STM-N card connected to third-party equipment. You create cross-connects at the
source and destination nodes so an Ethernet circuit can be routed from source to destination across
third-party equipment.
1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH where you will create the
cross-connect. If you are already logged in, continue with Step 2.
2. If you are provisioning an E-Series card, verify that the Ethernet card that will carry the circuit is
provisioned for port-mapped mode. See the "DLP-D246 Provision E-Series Ethernet Card Mode"
task.
3. If you are provisioning a G-Series card, complete the "DLP-D222 Provision G-Series Ethernet Ports"
task.
4. If you want to change the default flow control settings, complete the "DLP-D353 Provision G-Series
Flow Control Watermarks" task.
5. Click the Circuits tab and click Create.
6. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave the default (1) unchanged.
♦ Auto-ranged-Unavailable.
NTP-D148 Create a Manual Cross-Connect for a G-Series or E-Series Card in Port-Mapped Mode
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7. Click Next.
8. Define the circuit attributes:
♦ Name-Assign a name to the source cross-connect. The name can be alphanumeric and up to
48 characters (including spaces). Circuit names should be 44 characters or less if you want
the ability to create monitor circuits. If you leave the field blank, CTC assigns a default name
to the source cross-connect.
♦ Size-Choose the size of the circuit that will be carried by the cross-connect. Valid sizes for a
G-Series circuit are VC4, VC4-2c, VC4-3c, VC4-4c, VC4-8c, and VC4-16c. For an
E-Series circuit in port-mapped mode, valid sizes are VC4, VC4-2c, and VC4-4c.
♦ Bidirectional-Leave the default (checked) unchanged.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Uncheck this box.
♦ Protected Drops-Leave the default (unchecked) unchanged.
9. If the circuit will be routed on an SNCP ring, complete the "DLP-D218 Provision SNCP Ring
Selectors During Circuit Creation" task.
10. Click Next.
11. Provision the circuit source:
1. From the Node drop-down list, choose the circuit source node.
2. From the Slot drop-down list, choose the Ethernet card that will be the cross-connect source.
3. From the Port drop-down list, choose the cross-connect source port.
12. Click Next.
13. Provision the circuit destination:
1. From the Node drop-down list, choose the cross-connect source node selected in Step 11.
(For Ethernet cross-connects, the source and destination nodes are the same.)
2. From the Slot drop-down list, choose the STM-N card that connects to the non-ONS
equipment.
3. Depending on the STM-N card, choose the port and VC4 from the Port and VC4 drop-down
lists.
14. Click Next.
15. Verify the cross-connect information (in this step, "circuit" refers to the cross-connect):
♦ Circuit name
♦ Circuit type
♦ Circuit size
♦ ONS 15454 SDH circuit nodes
NTP-D148 Create a Manual Cross-Connect for a G-Series or E-Series Card in Port-Mapped Mode
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If the information is not correct, click the Back button and repeat the procedure with the
correct information. If the information is correct, check Route Automatically.
16. Complete the NTP-D149 Test G-Series Circuits for a G-Series card, or complete the NTP-D146 Test
E-Series Circuits for an E-Series card.
17. Click Finish.
Stop. You have completed this procedure.

NTP-D241 Provision G-Series Ports for Transponder Mode
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This task provisions G-Series ports for transponder mode.
None
NTP-D222 Provision G-Series Ethernet Ports
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at the node where you will provision G-Series ports. If
you are already logged in, continue with Step 2.
2. In the node view, double-click the G-Series card graphic to open the card.
3. Click the Provisioning >Port tabs.
4. To put a pair of G-Series card ports in two-port bidirectional transponder mode (Figure 6-10):
Note: In this step, "Port A" represents the first port in a pair and "Port B" the second port in
the pair. You can pair any two ports on a G-Series card in two-port bidirectional mode.
1. Click the Port A row (for example, Port 1).
2. In the TXP Port column, choose the port number that reflects Port A (for example, Port 1).
3. In the TXP Mode column, choose TX/RX from the drop-down list.
4. Click a Port B row (for example, Port 2).
5. In the TXP Port column, choose Port A (for example, Port 1) from the drop-down list.
6. In the TXP Mode column, choose TX/RX from the drop-down list.
7. Click Apply.
The ports in card view have arrows and a connecting line between the back of the
ports.
Figure 6-10: Two Port Bidirectional Transponder Mode
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5. To put a G-Series card port in one-port bidirectional transponder mode (Figure 6-11):
1. Click the desired port row (for example, Port 1).
2. In the TXP Port column, choose the desired port from the drop-down list (for example, Port
1).
3. In the TXP Mode column, choose TX/RX from the drop-down list.
4. Click Apply.
In card view, the desired port has arrows and a curved line on the back of the port.
Figure 6-11: One Port Bidirectional Transponder Mode

6. To provision two-port unidirectional transponder mode (Figure 6-12):
Note: In this step, "Port A" represents the first port in a pair and "Port B" the second
port in the pair. You can pair any two ports on a G-Series card in two-port
unidirectional mode.
Figure 6-10: Two Port Bidirectional Transponder Mode
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1. Click the Port A row (for example, Port 1).
2. Uncheck Auto Negotiation. Ports cannot be provisioned in unidirectional transponder mode
when autonegotiation is enabled.
3. In the TXP Port column, choose Port B (for example, Port 2) from the drop-down list.
4. In the TXP Mode column, choose RX Only from the drop-down list. CTC completes the
Port B TXP Port with Port A and TXP Mode with TX Only.
5. Click the Port B row and uncheck Auto Negotiation.
6. Click Apply.
The ports in CTC card view display arrows and a line between the back of the ports.
Figure 6-12: Two-Port Unidirectional Transponder Mode

Stop. You have completed this procedure.

NTP-D149 Test G-Series Circuits
Purpose
Tools/Equipment

This procedure tests circuits created on G-Series Ethernet cards.
Ethernet test set and appropriate fibers
This procedure assumes that you completed facility loopback tests to test the fibers and
cables from the source and destination ONS 15454 SDHs to the fiber distribution panel
or the DSX, and one of the following procedures:

Prerequisite
Procedures

NTP-D323 Create an Automatically Routed High-Order Circuit
NTP-D324 Create a Manually Routed High-Order Circuit
NTP-D148 Create a Manual Cross-Connect for a G-Series or E-Series Card in
Port-Mapped Mode

Required/As
Needed
Onsite/Remote
Security Level

As needed
Onsite
Provisioning or higher

Figure 6-11: One Port Bidirectional Transponder Mode
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1. Complete the "DLP-D60 Log into CTC" task at the ONS 15454 SDH source Ethernet node. If you
are already logged in, continue with Step 2.
2. Complete the "DLP-D230 Change a Circuit State" task and change the circuit and circuit ports to the
Locked-enabled,maintenance service state.
3. On the shelf graphic, double-click the circuit source card.
4. Click the Provisioning > Port tabs.
5. Verify the following settings:
♦ Service State-Locked-enabled,maintenance
♦ Flow Control-Checked or unchecked as indicated by the circuit or site plan
♦ Max Size-Check or unchecked as indicated by the circuit or site plan
♦ Media Type-SX, LX, ZX, CWDM, or DWDM for G-Series
6. Repeat Steps 1 through 5 for the destination node.
7. At the destination node, connect the Ethernet test set to the destination port and configure the test set
to send and receive the appropriate Ethernet traffic.
Note: At this point, you are not able to send and receive Ethernet traffic.
8. At the source node, connect the Ethernet test set to the source port and configure the test set to send
and receive the appropriate Ethernet traffic.
9. Transmit Ethernet frames between both test sets. If you cannot transmit and receive Ethernet traffic
between the nodes, repeat Steps 1 through 8 to make sure that you configured the Ethernet ports and
test set correctly.
10. Perform protection switch testing appropriate to the SDH topology:
♦ For SNCP rings, complete the "DLP-D94 SNCP Protection Switching Test" task.
♦ For MS-SPRings, complete the "DLP-D91 MS-SPRing Switch Test" task.
Configure your test set according to local site practice. For information about configuring
your test set, see your test set user guide.
11. Complete the "DLP-D230 Change a Circuit State" task and change the circuit ports to the
Unlocked-enabled service state.
12. After the circuit test is complete, print the results or save them to a disk for future reference. For
information about printing or saving test results, see your test set user guide.
Stop. You have completed this procedure.

NTP-D194 Create Overhead Circuits
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

This procedure creates overhead circuits on an ONS 15454 SDH network. Overhead
circuits include DCC tunnels, IP-encapsulated tunnels, the AIC-I card orderwire, and
the AIC-I card user data channel (UDC).
None
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the overhead circuit. If you are already logged in, continue with Step 2.
2. From the View menu, choose Go to Network View.
3. As needed, complete the "DLP-D361 Create a DCC Tunnel" task.
4. As needed, complete the "DLP-D4 Create an IP-Encapsulated Tunnel" task.
5. As needed, complete the "DLP-D83 Provision Orderwire" task.
6. As needed, complete the "DLP-D212 Create a User Data Channel Circuit" task.
NTP-D149 Test G-Series Circuits
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Stop. You have completed this procedure.

NTP-D283 Create an Automatically Routed VCAT Circuit
Purpose
Tools/Equipment

This procedure creates an automatically routed VCAT circuit. For more information
about VCAT circuits, refer to the "Circuits and Tunnels" chapter in the Cisco ONS
15454 SDH Reference Manual.
ML-Series, CE-100T-8, CE-1000-4,CE-MR-10, or FC_MR-4 cards must be installed
at the nodes used in the VCAT circuit.

Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite
Security Level
Provisioning or higher
Note: This procedure requires the use of automatic routing. Automatic routing is not available if both the
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE default
are set to FALSE. For a full description of these defaults see the "Network Element Defaults" appendix in the
Cisco ONS 15454 SDH Reference Manual.
1. Complete the "DLP-D60 Log into CTC" task at the node where you will create the VCAT circuit. If
you are already logged in, continue with Step 2.
2. Complete the following as necessary (you can provision Ethernet or POS ports before or after the
VCAT circuit is created):
♦ To provision Ethernet ports for CE-100T-8 or CE-MR-10 circuits, complete the "DLP-D136
Provision CE-100T-8 and CE-MR-10 Ethernet Ports" task.
♦ To provision Ethernet ports for CE-1000-4 circuits, complete the "DLP-D211 Provision
CE-1000-4 Ethernet Ports" task.
♦ To provision POS ports for CE-Series circuits, complete the "DLP-D141 Provision
CE-100T-8, CE-1000-4, and CE-MR-10 POS Ports" task.
♦ To provision Ethernet ports for ML-Series circuits, complete the "DLP-D493 Provision the
Ethernet Port of the ML-Series Card" task.
♦ To provision POS ports for ML-Series circuits, complete the "DLP-D494 Provision the POS
Port of the ML-Series Card" task.
3. From the View menu, choose Go to Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, choose VC_HO_PATH_VCAT_CIRCUIT from the Circuit
Type drop-down list.
6. Click Next.
7. Define the circuit attributes (Figure 6-13):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Type-Displays the circuit type you chose in Step 5. You cannot change it.
♦ Bidirectional-Checked is the default. You cannot change it.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose Unlocked.

NTP-D194 Create Overhead Circuits
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♦ Apply to drop ports-Check this check box to apply the IS administrative state to the circuit
source and destination ports. CTC applies the administrative state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the port. If not, a Warning dialog box
shows the ports where the administrative state could not be applied. If the check box is
unchecked, CTC does not change the service state of the source and destination ports.
♦ Symmetric-Checked is the default. You cannot change it.
♦ Member size-Choose the member size. For information about the member size supported for
each card, refer to the "Circuits and Tunnels" chapter in the Cisco ONS 15454 SDH
Reference Manual.
♦ Num. of members-Choose the number of members. For information about the number of
members supported for each card, refer to the "Circuits and Tunnels" chapter in the Cisco
ONS 15454 SDH Reference Manual.
Note: When creating open-ended VCAT circuits the number of members must be the same
on each side of the virtual concatenated group (VCG). The configuration with different
number of members on each side of circuit is not supported. This is applicable to circuits
created on CE-Series and ML-Series cards.
♦ Mode-Choose the protection mode for the VCAT circuit:
◊ None-Provides no protection. A failure on one member causes the entire VCAT
circuit to fail. You cannot delete members after creating a VCAT circuit with no
protection.
◊ SW-LCAS-(Software link capacity adjustment scheme) Allows the VCAT circuit to
adapt to member failures and keep traffic flowing after failures at a reduced
bandwidth. SW-LCAS provides interoperability with the ML-Series cards.
SW-LCAS uses legacy SONET failure indicators like path alarm indication signal
(AIS-P) and path remote defect indication (RDI-P) to detect member failure. You
cannot add or delete members from a VCAT circuit with SW-LCAS protection.
Note: While deleting SW-LCAS circuit members place the members in the Locked,disabled,
state. This is applicable to circuits created on CE-Series and ML-Series cards.
◊ LCAS-Sets the VCAT circuit to use LCAS. With LCAS, you can add or delete members
without interrupting the operation of uninvolved members. If a member fails, LCAS
temporarily removes the failed member from the VCAT circuit. The remaining members
carry the traffic until the failure clears.
Note: For CE-MR-10 card, before you create a VCAT circuit in the LCAS protection mode,
it is recommended that you move all members of the VCAT circuit being created to
Locked,OutOfGroup service state and then move them to Unlocked state.
Note: While deleting HW-LCAS circuit members change the administrative state of the
members to Locked, OutOfGroup. This is applicable to circuits created on CE-Series and
ML-Series cards.
Figure 6-13: Setting VCAT Circuit Attributes
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8. Click Next.
9. Complete the "DLP-D36 Provision a VCAT Circuit Source and Destination" task for the VCAT
circuit you are creating. If you are creating an open-ended VCAT circuit, complete the "DLP-D290
Provision an Open VCAT Circuit Source and Destination" task.
10. In the VCAT Circuit Routing Preferences area (Figure 6-14), check Route Automatically. Two
options are available; choose either, both, or none based on your preferences.
⋅ Using Required Nodes/Spans-Check this check box to specify nodes and spans to
include or exclude in the CTC-generated circuit route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
⋅ Review Route Before Creation-Check this check box to review and edit the circuit
route before the circuit is created.
Figure 6-14: Automatically Routing a VCAT Circuit

11. If you want to set preferences for individual members, complete the following in the Member
Preferences area. Repeat for each member and continue with Step 13. To set identical preferences for
all members, skip this step and continue with Step 12.
1. Number-Choose a number (between 1 and 256) from the drop-down list to identify the
member.
2. Name-Type a unique name to identify the member. The name can be alphanumeric and up to
48 characters (including spaces). If you leave the field blank, CTC assigns a default name to
the circuit.
3. Protection-Choose the member protection type:
Figure 6-13: Setting VCAT Circuit Attributes
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• Fully Protected-Routes the circuit on a protected path.
• Unprotected-Creates an unprotected circuit.
• PCA-Routes the member on an MS-SPRing protection channel.
12. To set preferences for all members, choose the member protection type:
⋅ Fully Protected-Routes the circuit on a protected path.
⋅ Unprotected-Creates an unprotected circuit.
⋅ PCA-Routes the member on a MS-SPRing protection channel.
13. Click Next. If you chose Fully Protected or PCA, click OK to continue. If not, continue with the next
step.
14. If you selected Using Required Nodes/Spans in Step 10, complete the following substeps. If not,
continue with Step 15:
1. In the Circuit Route Constraints For Auto Routing area, choose the member that you want to
route from the Route member number drop-down list.
2. Click a node or span on the circuit map.
3. Click Include to include the node or span in the circuit, or click Exclude to exclude the node
or span from the circuit. The order in which you choose included nodes and spans is the
order in which the circuit is routed. Click spans twice to change the circuit direction.
4. Repeat Substeps 2 and 3 for each node or span that you wish to include or exclude.
5. Review the circuit route. To change the circuit routing order, choose a node in the Required
Nodes/Lines or Excluded Nodes Links lists, then click the Up or Down buttons to change
the circuit routing order. Click Remove to remove a node or span.
6. Repeat SubSteps 1 through 5 for each member.
15. If you selected Review Route Before Creation in Step 10, complete the following substeps;
otherwise, continue with Step 16:
1. In the Route Review/Edit area, choose the member that you want to route from the Route
member number drop-down list.
2. Click a node or span on the circuit map.
3. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route.
Blue arrows show the circuit route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
4. If the provisioned circuit does not reflect the routing and configuration you want, click Back
to verify and change circuit information. If the circuit needs to be routed to a different path,
see the NTP-D284 Create a Manually Routed VCAT Circuit to assign the circuit route
yourself.
5. Repeat SubSteps 1 through 4 for each member.
16. Click Finish. The Circuits window appears.
Note: Depending on the complexity of the network and number of members, the
VCAT circuit creation process might take several minutes.
17. In the Circuits window, verify that the circuit you created appear in the circuits list.
Stop. You have completed this procedure.

NTP-D284 Create a Manually Routed VCAT Circuit
Purpose
Tools/Equipment

This procedure creates a manually routed VCAT circuit. For more information about
VCAT circuits, refer to the "Circuits and Tunnels" chapter of the Cisco ONS 15454
SDH Reference Manual.
ML-Series, CE-100T-8, CE-MR-10, CE-1000-4, or FC_MR-4 cards must be installed
at the nodes used in the VCAT circuit.
NTP-D127 Verify Network Turn-Up

Figure 6-14: Automatically Routing a VCAT Circuit
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Prerequisite
Procedures
Required/As
Needed
Onsite/Remote
Security Level

As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at the node where you will create the circuit. If you are
already logged in, continue with Step 2.
2. If you want to assign a name to the tunnel source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 6.
3. Complete the following as necessary (you can provision Ethernet or POS ports before or after the
VCAT circuit is created):
♦ To provision Ethernet ports for CE-100T-8 or CE-MR-10 circuits, complete the "DLP-D136
Provision CE-100T-8 and CE-MR-10 Ethernet Ports" task.
♦ To provision Ethernet ports for CE-1000-4 circuits, complete the "DLP-D211 Provision
CE-1000-4 Ethernet Ports" task.
♦ To provision POS ports for CE-Series circuits, complete the "DLP-D141 Provision
CE-100T-8, CE-1000-4, and CE-MR-10 POS Ports" task.
♦ To provision Ethernet ports for ML-Series circuits, complete the "DLP-D493 Provision the
Ethernet Port of the ML-Series Card" task.
♦ To provision POS ports for ML-Series circuits, complete the "DLP-D494 Provision the POS
Port of the ML-Series Card" task.
4. From the View menu, choose Go to Network View.
5. In the Circuit Creation dialog box, choose VC_HO_PATH_VCAT_CIRCUIT from the Circuit
Type drop-down list.
6. Click Next.
7. Define the circuit attributes (Figure 6-13):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Type-Displays the circuit type you chose in Step 5. You cannot change it.
♦ Bidirectional-Checked is the default. You cannot change it.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose Unlocked.
♦ Apply to drop ports-Check this check box to apply the IS administrative state to the circuit
source and destination ports. CTC applies the administrative state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the port. If not, a Warning dialog box
shows the ports where the administrative state could not be applied. If the check box is
unchecked, CTC does not change the service state of the source and destination ports.
♦ Symmetric-Checked is the default. You cannot change it.
♦ Member size-Choose the member size. For information about the member size supported for
each card, refer to the "Circuits and Tunnels" chapter in the Cisco ONS 15454 SDH
Reference Manual.
♦ Num. of members-Choose the number of members. For information about the number of
members supported for each card, refer to the "Circuits and Tunnels" chapter in the Cisco
ONS 15454 SDH Reference Manual.
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Note: When creating open-ended VCAT circuits the number of members must be the same
on each side of the virtual concatenated group (VCG). The configuration with different
number of members on each side of circuit is not supported. This is applicable to circuits
created on CE-Series and ML-Series cards.
♦ Mode-Choose the protection mode for the VCAT circuit:
◊ None-Provides no protection. A failure on one member causes the entire VCAT
circuit to fail. You cannot delete members after creating a VCAT circuit with no
protection.
◊ SW-LCAS-Allows the VCAT circuit to adapt to member failures and keep traffic
flowing after failures at a reduced bandwidth. SW-LCAS provides interoperability
with the ML-Series cards. SW-LCAS uses legacy SONET failure indicators like
AIS-P and RDI-P to detect member failure. You cannot add or delete members from
a VCAT circuit with SW-LCAS protection.
Note: While deleting SW-LCAS circuit members place the members in the Locked,disabled,
state. This is applicable to circuits created on CE-Series and ML-Series cards.
♦ LCAS-Sets the VCAT circuit to use LCAS. With LCAS, you can add or delete members
without interrupting the operation of uninvolved members. If a member fails, LCAS
temporarily removes the failed member from the VCAT circuit. The remaining members
carry the traffic until the failure clears.
Note: For CE-MR-10 card, before you create a VCAT circuit in the LCAS protection mode,
it is recommended that you move all members of the VCAT circuit being created to
Locked,OutOfGroup service state and then move them to Unlocked state.
Note: While deleting HW-LCAS circuit members change the administrative state of the
members to Locked, OutOfGroup. This is applicable to circuits created on CE-Series and
ML-Series cards.
8. Click Next.
9. Complete the "DLP-D36 Provision a VCAT Circuit Source and Destination" task for the VCAT
circuit you are creating. If you are creating an open-ended VCAT circuit, complete the "DLP-D290
Provision an Open VCAT Circuit Source and Destination" task.
10. In the Circuit Routing Preferences area (Figure 6-14), uncheck Route Automatically.
11. If you want to set preferences for individual members, complete the following in the Member
Preferences area. Repeat for each member and continue with Step 13. To set identical preferences for
all members, skip this step and continue with Step 12.
1. Number-Choose a number (between 1 and 256) from the drop-down list to identify the
member.
2. Name-Type a unique name to identify the member. The name can be alphanumeric and up to
48 characters (including spaces). If you leave the field blank, CTC assigns a default name to
the circuit.
3. Protection-Choose the member protection type:
◊ Fully Protected-Routes the circuit on a protected path.
◊ Unprotected-Creates an unprotected circuit.
◊ PCA-Routes the member on a MS-SPRing protection channel.
12. To set preferences for all members, choose the member protection type:
♦ Fully Protected-Routes the circuit on a protected path.
♦ Unprotected-Creates an unprotected circuit.
♦ PCA-Routes the member on a MS-SPRing protection channel.
13. Click Next. If you chose Fully Protected or PCA, click OK to continue. If not, continue with the next
step.
14. In the Route Review and Edit area, node icons appear so you can route the circuit manually.
15. Complete the "DLP-D26 Provision a VCAT Circuit Route" task.
16. Click Finish.
Note: Depending on the complexity of the network and number of members, the VCAT
circuit creation process might take several minutes.
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17. When all the circuits are created, the Circuits window appears. Verify that the circuit you created
appears in the window.
18. Complete the NTP-D62 Test High-Order Circuits.
Stop. You have completed this procedure.

NTP-D325 Create an STM Test Circuit around the Ring
Purpose
Tools/Equipment
Prerequisite
Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates an STM test circuit that routes traffic around a ring with the
source and destination located on different ports of the same node.
None
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at an ONS 15454 SDH on the network where you will
create the circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If you want CTC to assign a name
automatically based on circuit type, node name, and sequence number, continue with Step 3.
3. From the View menu, choose Go to Network View.
4. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Enter the number of high-order circuits that you want to create. The
default is 1.
♦ Auto-ranged-(Applies to automatically routed circuits only) If you entered more than 1 in
Number of Circuits, uncheck this check box. (The check box is unavailable if only one
circuit is entered in Number of Circuits.)
5. Click Next.
6. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose the high-order circuit size: VC4, VC4-2c, VC4-3c, VC4-4c, VC4-8c,
VC4-16c, or VC4-64c.
♦ Bidirectional-Leave checked for this circuit.
♦ Create cross-connects only (TL1-like)-Check this check box if you want to create one or
more cross-connects to complete a signal path for TL1-generated circuits. If you check this
box, low-order tunnels and Ethergroup sources and destinations are unavailable.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
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◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task.
For additional information about circuit service states, refer to the "Circuits and
Tunnels" chapter in the Cisco ONS 15454 SDH Reference Manual.
♦ Apply to drop ports-Check this box if you want to apply the state chosen in the State field to
the circuit source and destination ports. CTC applies the circuit state to the ports only if the
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than
the circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog
box shows the ports where the circuit state could not be applied. If the box is unchecked,
CTC does not change the state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
♦ Protected Drops-Select this check box if you want the circuit routed to protect drops only,
that is, to ONS 15454 SDH cards that are in 1:1, 1:N, or 1+1 protection. If you select this
check box, CTC shows only protected cards as source and destination choices.
7. Click Next.
8. Choose the circuit source:
1. From the Node drop-down list, choose the node where the circuit will originate.
2. From the Slot drop-down list, choose the slot containing the high-order card where the
circuit originates. (If a card's capacity is fully utilized, it does not appear in the drop-down
list.)
3. Depending on the circuit origination card, choose the source port and/or VC-4 from the Port
and VC-4 drop-down lists. The Port drop-down list is only available if the card has multiple
ports. VC-4s are not shown if they are already in use by other circuits.
Note: The VC4s that appear depend on the card, circuit size, and protection scheme.
9. Click Next.
10. Choose the circuit destination:
Note: The destination port must be located on the same node as the circuit source port.
1. From the Node drop-down list, choose the node selected in Substep 1 of Step 8.
2. From the Slot drop-down list, choose the slot containing the optical card where the circuit
will terminate (destination card). (If a card's capacity is fully utilized, the card does not
appear in the drop-down list.)
3. Depending on the card selected in SubStep 2, choose the destination port and/or VC-4 from
the Port and VC-4 drop-down lists. The Port drop-down list is available only if the card has
multiple ports. The VC-4s that appear depend on the card, circuit size, and protection
scheme.
11. Click Next.
12. In the Circuit Routing Preferences area, uncheck Route Automatically.
13. When routing a test circuit with source and destination ports on the same node, the Fully Protected
Path check box is automatically disabled. Choose one of the following options:
♦ To leave the test circuit unprotected, continue with Step 14.
♦ To route the test circuit on a MS-SPRing protection channel, check Protection Channel
Access, click Yes in the Warning dialog box, then continue with Step 14.
Caution! Circuits routed on MS-SPRing protection channels are not protected and are preempted during
MS-SPRing switches.
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14. Click Next. In the Route Review/Edit area, node icons appear for you to route the circuit manually.
15. Complete the "DLP-D98 Provision a High-Order Circuit Route" task.
16. Click Finish. If you entered more than 1 in the Number of Circuits field, the Circuit Creation dialog
box appears after the circuit is created so you can create the remaining circuits. Repeat Steps 6
through 15 for each additional circuit.
17. When all the circuits are created, the main Circuits window appears. Verify that the circuits you
created appear in the window.
18. Complete the NTP-D62 Test High-Order Circuits.
Stop. You have completed this procedure.

NTP-D350 Create a Server Trail
Purpose

This procedure creates a server trail, which provides a connection between ONS
nodes through a third-party network. You can create server trails between any two
STM-N ports.
None

Tools/Equipment
Prerequisite
NTP-D127 Verify Network Turn-Up
Procedures
Required/As
As needed
Needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher
Note: You cannot create server trails on ports with DCC links.

1. Complete the "DLP-D60 Log into CTC" task at the node where you will create the circuit. If you are
already logged in, continue with Step 2.
2. From the View menu, choose Go to Network View.
3. Click the Provisioning > Server Trails tabs.
4. Click Create.
5. In the Server Trail Creation dialog box, complete the following fields:
♦ Type-Choose VC_HO_PATH_CIRCUIT or VC_LO_PATH_CIRCUIT.
♦ Size-Depending on the type selected, choose the server trail size. For
VC_HO_PATH_CIRCUIT, choose VC4-2c, VC4-3c, VC4-4c, VC4-6c, VC4-8c, VC4-12c,
VC4-16c, VC4-64c, or VC4. For VC_LO_PATH_CIRCUIT, choose VC3, VC12, or VC11.
♦ Protection Type-Choose one of the following protection types: Preemptible, Unprotected, or
Fully Protected. The server trail protection sets the protection type for any circuit that
traverses it.
• Preemptible- PCA circuits will use server trails with the Preemptible attribute.
• Unprotected-In Unprotected Server Trail, CTC assumes that the circuits going out
from that specific port will not be protected by provider network and will look for a
secondary path from source to destination if you are creating a protected circuit.
• Fully Protected-In Fully Protected Server Trail, CTC assumes that the circuits going
out from that specific port will be protected by provider network and will not look
for a secondary path from source to destination.
◊ Number of Trails-Enter the number of server trails. Number of trails determine the number
of circuits that can be created on server trail. You can create a maximum of 3744 server trails
on a node. You can create multiple server trails from the same port. This is determined by
how many circuits of a particular server trail size can be supported on the port (for example,
you can create three VC4 server trails from one STM-3 port or two VC3 and six VC11
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server trails from one STM-3 port).
6. Click Next.
7. In the Source area, complete the following:
1. From the Node drop-down list, choose the node where the source will originate.
2. From the Slot drop-down list, choose the slot containing the card where the server trail
originates. (If a card's capacity is fully utilized, the card does not appear in the list.)
3. Depending on the origination card, choose the source port and/or VC4 or VC11 from the
Port and VC4 or VC11 lists. The Port list is only available if the card has multiple ports.
VC4s and VC11s do not appear if they are already in use by other circuits.
8. Click Next.
9. In the Destination area, complete the following:
1. From the Node drop-down list, choose the destination node.
2. From the Slot drop-down list, choose the slot containing the card where the server trail will
terminate (destination card). (If a card's capacity is fully utilized, the card does not appear in
the list.)
3. Depending on the card selected, choose the destination port and/or VC4 or VC11 from the
Port and VC4 or VC11 lists. The Port list is only available if the card has multiple ports.
VC4s and VC11s do not appear if they are already in use by other circuits.
10. Click Finish.
Stop. You have completed this procedure.

NTP-D358 Create an Automatically Routed Open-Ended SNCP
High-Order Circuit
Purpose
Tools/Equipment
Prerequisite Procedures
Required/As Needed
Onsite/Remote
Security Level

This procedure creates an open-ended high-order SNCP.
None
NTP-D127 Verify Network Turn-Up
As needed
Onsite or remote
Provisioning or higher

1. Complete the "DLP-D60 Log into CTC" task at a node on the network where you want to create the
circuit. If you are already logged in, continue with Step 2.
2. If you want to assign a name to the circuit source and destination ports before you create the circuit,
complete the "DLP-D314 Assign a Name to a Port" task. If not, continue with Step 3.
3. From the View menu, choose Go To Network View.
4. Click the Circuits tab, then click Create.
5. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave set to 1.
♦ Auto-ranged-Leave unchecked.
6. Click Next.
7. Define the circuit attributes (Figure 6-1: Setting Circuit Attributes for a Low-Order VC11 Circuit):
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
♦ Size-Choose VC-4.
♦ Bidirectional-As desired. When checked, CTC creates a two-way circuit.
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♦ Create cross-connects only (TL1-like)-Check this check box to create one or more
cross-connects to complete a signal path for TL1-generated circuits. If you are creating an
open-ended high-order SNCP circuit to bridge low-order traffic, you must check this check
box.
♦ Diagnostic-Leave unchecked.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
"DLP-D230 Change a Circuit State" task. For additional information about circuit
service states, refer to the "Circuits and Tunnels" chapter in the Cisco ONS 15454
SDH Reference Manual.
♦ Apply to drop ports-Check this check box if you want to apply the administrative state
chosen in the State field to the circuit source and destination ports. CTC applies the
administrative state to the ports only if the circuit bandwidth is the same as the port
bandwidth or, if the port bandwidth is larger than the circuit, the circuit must be the first
circuit to use the port. If not, a Warning dialog box displays the ports where the
administrative state could not be applied. If the check box is unchecked, CTC does not apply
the administrative state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
♦ Protected Drops-If selected, CTC displays only protected cards and ports (1+1 protection) as
choices for the circuit source and destination.
8. If the circuit will be routed on an SNCP ring, complete the "DLP-D230 Change a Circuit State" task.
9. Click Next.
10. Complete the "DLP-D97 Provision a High-Order Circuit Source and Destination" task for the optical
circuit that you are creating. Choose a single source and secondary destinations to create the
open-ended SNCP circuit.
11. In the Circuit Routing Preferences area (Figure 6-2), check Route Automatically. Two options are
available; choose either, both, or none based on your preferences.
♦ Using Required Nodes/Spans-Check this box to specify nodes and spans to include or
exclude in the CTC-generated circuit route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
♦ Review Route Before Creation-Check this box to review and edit the circuit route before the
circuit is created.
12. Leave Fully Protected Path checked.
13. Choose one of the following:
♦ Nodal Diversity Required-Ensures that the primary and alternate paths within the SNCP ring
portions of the complete circuit path are nodally diverse.

NTP-D358 Create an Automatically Routed Open-Ended SNCP High-Order Circuit

93

ONS_15454_SDH_Procedure_Guide_R8.5.1_--_Create_Circuits_and_Low-Order_Tunnels
♦ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node diversity is not
possible, CTC creates fiber-diverse paths for the SNCP ring portion of the complete circuit
path.
♦ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths for SNCP
ring portions of the complete circuit path are needed. The paths might be node-diverse, but
CTC does not check for node diversity.
14. Click Next. If you selected Review Route Before Creation in Step 12, complete the following
substeps; otherwise, continue with Step 15:
1. Click Next.
2. Review the circuit route. To add or delete a circuit span, select a node on the circuit route.
Blue arrows show the circuit route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned circuit does not reflect the routing and configuration you want, click Back
to verify and change circuit information. If the circuit needs to be routed to a different path,
see the NTP-D324 Create a Manually Routed High-Order Circuit to assign the circuit route
yourself.
15. Click Finish. If the path does not meet the specified path diversity requirement, an error message
appears and allows you to change the circuit path. If you entered more than 1 in the Number of
circuits field, the Circuit Creation dialog box appears after the circuit is created so you can create the
remaining circuits. Repeat Steps 5 through 15 for each additional circuit.
16. When all the circuits are created, the main Circuits window appears. Verify that the circuit(s) you
created appear in the window.
17. Complete the NTP-D62 Test High-Order Circuits.
Stop. You have completed this procedure.

NTP-D375 Manually Create a CCAT or VCAT Circuit on the
CE-MR-10 Card
This procedure manually creates a CCAT or VCAT circuit on the CE-MR-10
Card.
Tools/Equipment
None
Prerequisite Procedures NTP-D127 Verify Network Turn-Up
Required/As Needed
As needed
Onsite/Remote
Onsite or remote
Security Level
Provisioning or higher

Purpose

1. Complete the "DLP-D60 Log into CTC" task at the node where you will create the circuit. If you are
already logged in, continue with Step 2.
2. In the node view, double-click the CE-MR-10 card.
3. Click the Circuits > Circuits tabs and click Create.
4. In the Circuit Creation dialog box, complete the following fields:
♦ Circuit Type-Choose VC_HO_PATH_CIRCUIT.
♦ Number of Circuits-Leave set to 1.
♦ Auto-ranged-Leave unchecked.
5. Click Next.
6. Define the circuit attributes:
♦ Name-Assign a name to the circuit. The name can be alphanumeric and up to 48 characters
(including spaces). Circuit names should be 44 characters or less if you want the ability to
create monitor circuits. If you leave the field blank, CTC assigns a default name to the
circuit.
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♦ Size-Choose VC-4.
♦ Bidirectional-As desired. When checked, CTC creates a two-way circuit.
♦ Create cross-connects only (TL1-like)-Check this check box to create one or more
cross-connects to complete a signal path for TL1-generated circuits. If you are creating an
open-ended high-order SNCP circuit to bridge low-order traffic, you must check this check
box.
♦ Diagnostic-Leave unchecked.
♦ State-Choose the administrative state to apply to all of the cross-connects in a circuit:
◊ Unlocked-Puts the circuit cross-connects in the Unlocked-enabled service state.
◊ Locked,disabled-Puts the circuit cross-connects in the Locked-enabled,disabled
service state. Traffic is not passed on the circuit.
◊ Unlocked,automaticInService-Puts the circuit cross-connects in the
Unlocked-disabled,automaticInService service state and suppresses alarms and
conditions. When the connections receive a valid signal, the service state
automatically changes to Unlocked-enabled.
◊ Locked,maintenance-Puts the circuit cross-connects in the
Locked-enabled,maintenance service state. The maintenance state does not interrupt
traffic flow; it suppresses alarms and conditions and allows loopbacks to be
performed on the circuit. Use Locked,maintenance for circuit testing or to suppress
circuit alarms temporarily. Change the administrative state to Unlocked;
Unlocked,automaticInService; or Locked,disabled when testing is complete. See the
[[ONS 15454 SDH Procedure Guide R8.5.1 -- DLPs D200 to D299#"DLP-D230
Change a Circuit State" task on page 19-28. For additional information about circuit
service states, refer to the "Circuits and Tunnels" chapter in the Cisco ONS 15454
SDH Reference Manual.
♦ Apply to drop ports-Check this check box if you want to apply the administrative state
chosen in the State field to the circuit source and destination ports. CTC applies the
administrative state to the ports only if the circuit bandwidth is the same as the port
bandwidth or, if the port bandwidth is larger than the circuit, the circuit must be the first
circuit to use the port. If not, a Warning dialog box displays the ports where the
administrative state could not be applied. If the check box is unchecked, CTC does not apply
the administrative state of the source and destination ports.
Note: If ports managed into the Unlocked administrative state are not receiving signals, loss
of signal alarms are generated and the port service state transitions to
Unlocked-disabled,failed.
♦ Protected Drops-If selected, CTC displays only protected cards and ports (1+1 protection) as
choices for the circuit source and destination.
7. If the circuit will be routed on an SNCP ring, complete the "DLP-D230 Change a Circuit State" task.
8. Click Next.
9. Complete the "DLP-D97 Provision a High-Order Circuit Source and Destination" task for the optical
circuit that you are creating. Choose a single source and secondary destinations to create the
open-ended SNCP circuit.
10. In the Circuit Routing Preferences area, check Route Automatically. Two options are available;
choose either, both, or none based on your preferences.
♦ Using Required Nodes/Spans-Check this box to specify nodes and spans to include or
exclude in the CTC-generated circuit route.
Including nodes and spans for a circuit ensures that those nodes and spans are in the
working path of the circuit (but not the protect path). Excluding nodes and spans
ensures that the nodes and spans are not in the working or protect path of the circuit.
♦ Review Route Before Creation-Check this box to review and edit the circuit route before the
circuit is created.
11. Leave Fully Protected Path checked.
12. Choose one of the following:
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♦ Nodal Diversity Required-Ensures that the primary and alternate paths within the SNCP
ring portions of the complete circuit path are nodally diverse.
♦ Nodal Diversity Desired-Specifies that node diversity is preferred, but if node diversity is
not possible, CTC creates fiber-diverse paths for the SNCP ring portion of the complete
circuit path.
♦ Link Diversity Only-Specifies that only fiber-diverse primary and alternate paths for SNCP
ring portions of the complete circuit path are needed. The paths might be node-diverse, but
CTC does not check for node diversity.
13. Click Next. If you selected Review Route Before Creation in Step 10, complete the following
substeps; otherwise, continue with Step 14:
1. Click Next.
2. Review the circuit route. To add or delete a circuit span, select a node on the circuit route.
Blue arrows show the circuit route. Green arrows indicate spans that you can add. Click a
span arrowhead, then click Include to include the span or Remove to remove the span.
3. If the provisioned circuit does not reflect the routing and configuration you want, click Back
to verify and change circuit information. If the circuit needs to be routed to a different path,
see the NTP-D324 Create a Manually Routed High-Order Circuit to assign the circuit route
yourself.
14. Click Finish. If the path does not meet the specified path diversity requirement, an error message
appears and allows you to change the circuit path. If you entered more than 1 in the Number of
circuits field, the Circuit Creation dialog box appears after the circuit is created so you can create the
remaining circuits. Repeat Steps 4 through 14 for each additional circuit.
15. When all the circuits are created, the main Circuits window appears. Verify that the circuit(s) you
created appear in the window.
16. Complete the NTP-D62 Test High-Order Circuits.
Stop. You have completed this procedure.
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